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Introduction to the Format Guide 

Welcome to the University of South Carolina Graduate School format guide for electronic theses 
and dissertations (ETDs)!  

This guide provides you with an overview of the format check process; information on 
embargos, deadlines, and manuscript style; and has meticulous information about how exactly 
to format your ETD, including formatting requirements, samples, and directions. There is also a 
section on tips for navigating Microsoft Word, complete with images and alt-text.  

The purpose of this format guide is to ensure you have access to requirements mandated by the 
Graduate School. These requirements are not optional, so you do need to follow this guide as 
you format your ETD.  

Please note that this guide does not encompass every formatting question possible. 
Additionally, you should consult your department’s approved style manual for more discipline-
specific formatting choices, such as whether to double space footnotes or how to format a 
bibliographic entry. However, in situations in which there is a conflict between what your style 
manual instructs and what the format guide states, you must always opt for the format guide’s 
instructions. This is because your ETD must conform to the Graduate School’s requirements for 
you to graduate.  

Why Formatting is Important 

Formatting may seem trivial, but it is in fact an integral part of your document’s overall 
presentation. Your thesis or dissertation could contain some of the most important and 
innovative research in your field, but if it is presented in a sloppy manner—if your fonts don’t 
match, your margins are skewed, your heading choices are inconsistent, your entries in the 
table of contents don't match what is in your document—then the brilliance and innovation of 
your research will be hidden behind a poor presentation. Instead, the poor formatting will 
obscure your research because the mistakes will appear far more readily apparent than what 
you actually have to say.  

Moreover, as you progress in your post-graduate career, you will undoubtedly pursue publishing 
in academic journals or books, or you will apply for grants and research funding. All of these 
kinds of publications have formatting requirements—requirements that you will be expected to 
follow in order to be considered acceptable—so it is important to focus on formatting and 
adhering to requirements.  

At the Graduate School, we have created formatting requirements that apply to all theses and 
dissertations equally to ensure your document is formatted properly and consistently. Meeting 
these requirements is essential not only to graduating, but to guaranteeing your document is 
able to be read by fellow scholars, meets publishing standards for journals and databases, and, 
above all, will be presentable and polished enough to ensure your work is taken seriously.  

INTRODUCTION 
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You must meet three deadlines for your ETD in order to be eligible for graduation. These 
deadlines are required; if you miss a key deadline, you can jeopardize your graduation 
eligibility. You can find these specific dates on the Graduate School’s website. 

Deadline Description Date(s) 
Format Check Deadline First deadline you must meet. Make your 

initial submission to review your 
document. The content does not need to 
be finalized. You will have the opportunity 
to revise the content and formatting after 
this submission.  

You are encouraged to submit your work
or a preliminary format approval (see 
age 6 of the format guide).  

 
f
p

Early in the 
semester 

Defense Deadline If your department requires a defense, this 
is the deadline by which you must defend 
your work.  

Later in semester 

Final Submission 
Deadline 

The deadline by which you must submit 
your final, most perfect version. You 
cannot revise content after this date. 

Near the end of the 
semester.  

The Electronic Thesis and Dissertation (ETD) Coordinator will review your document for the 
format check. You can contact this person with any questions about your format check status, 
formatting concerns, or anything else related to the ETD submission process.  

ETD Coordinator: Laura Kotti 

Email: kotti@mailbox.sc.edu 

Phone: 803-777-4244 

Office: Close-Hipp Building, Suite 552 

DEADLINES 

ETD COORDINATOR CONTACT INFORMATION 

https://www.sc.edu/study/colleges_schools/graduate_school/academics/thesis_and_dissertation/
mailto:kotti@mailbox.sc.edu
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If you wish to publish any of your work or need to prevent other scholars from viewing or 
downloading your work, you can request an embargo. This option can keep your work from 
becoming accessible for an allotted amount of time. Note that work cannot be embargoed 
permanently. As a public institution, USC can only embargo work for a total of 10 years.  

Embargo Process 

To request an embargo, you will first need to choose the embargo option on your Dissertation 
Signature and Approval form (G-DSF) or Master’s Thesis Signature Approval Form (G-TSF). 
You can choose an embargo length of 6 months, 1 year, or 2 years. In addition, you are 
required to submit a letter or memo addressed to the Graduate School that contains the 
following information: 

 Name of student and your USC ID (9-digit alpha-numeric number)
 Title of electronic thesis or dissertation (ETD)
 Justification for embargo
 Length of embargo (6 months, 1 year, or 2 years)
 Signature of your major professor and/or head of department

Once the Graduate School has received this memo and your G-DSF or G-TSF, your embargo 
will be processed.  

Please note that you must select the Delayed Release option in your ProQuest ETD account. If 
you do not do this, your work will become visible in ProQuest’s databases.  

Embargo Renewals 

At the end of your embargo, you have the option to renew. You can renew in an increment of 6 
months, 1 year, or 2 years. You are not required to use the same embargo length as before. 
Altogether, you can embargo your work for a total of 10 years cumulatively, renewing at one of 
the allotted intervals.  

Each extension request must be accompanied by a letter from the major professor or 
department head (if the major professor is no longer at the institution) justifying the extension, 
and all extensions are subject to approval by the Graduate School.  

Extension requests must be received by the Graduate School at least thirty days before the 
expiration of the previous embargo period.  

It is also important to note that students have a separate agreement with ProQuest/UMI that is 
not affected by any embargo requests made to the University of South Carolina; likewise, any 
agreement students have with ProQuest/UMI does not affect their agreement with the 
University.  

To renew your embargo with ProQuest, you will need to contact them directly at 
disspub@proquest.com or by chat at their website, https://support.proquest.com/chat. 

EMBARGO PROCESS AND EMBARGO RENEWALS 

https://www.sc.edu/study/colleges_schools/graduate_school/documents/dissertation-signature-approval.pdf
https://www.sc.edu/study/colleges_schools/graduate_school/documents/g-tsf.pdf
mailto:disspub@proquest.com
https://support.proquest.com/chat
https://support.proquest.com/s/chat?language=en_US
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Submitting for the First Time 
Steps Tips 
1. Log in for first time This is a new account 

Create password 

2. Email addresses Required to have USC email for all format check 
communication. 
Required to have personal email for post-graduation 
communication with ProQuest. 

3. Order hard copies Optional, but do this now because it is harder to order 
copies later. 

4. Enter all ETD information Must match what is in your G-DSF or G-TSF 
is in university records Name must match what 

Title must match what is on title page 

5. Graduation information Enter correct graduation month: 
 May; or
 August; or
 December

6. Click “Submit” Guarantees ETD Coordinator gains access to your 
submission 

Contents

You will submit your work for the format check through a website called ETD Administrator, 
which is a part of ProQuest/UMI. You can access this link also through the Graduate School’s 
website, clicking on the link that reads “Submit Your Thesis/Dissertation.” 

Please review and apply all formatting requirements before you submit. The more work your 
ETD needs, the longer the process will take for you to make revisions. Keep in mind these rules 
with submitting your ETD for the format check: 

 No paper submissions are accepted. The entire format check process is electronic. You
can only use the ETD Administrator system to submit your work.

 The Graduate School does not accept emailed submissions. All submissions must go
through the ETD Administrator system.

 When resubmitting your work, continue to use your original account. Do not create a
new account when you resubmit. You are only allowed to have one account in the ETD
system.

 The first submission you make is not the version that will be published. The final,
accepted version in your account is the one that you will receive as a hard copy and will
be published in the appropriate databases.

HOW TO SUBMIT YOUR ETD TO THE GRADUATE SCHOOL 

https://www.etdadmin.com/main/home?siteId=145
https://www.sc.edu/study/colleges_schools/graduate_school/academics/thesis_and_dissertation/index.php
https://www.sc.edu/study/colleges_schools/graduate_school/documents/dissertation-signature-approval.pdf
https://www.sc.edu/study/colleges_schools/graduate_school/documents/g-tsf.pdf
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Format Check Process 

You click 
"Submit" on first 

submission
Account is all ready

ETD Coordinator 
receives 

notification
Only if you hit 

"submit"!

ETD Coordinator 
reviews 

document
May take several 

days

ETD Coordinator 
sends you 
comments

Goes to your USC 
email address you 

entered in your ETD 
account

You log in to 
SAME account

Do NOT create a 
new account!

You submit 
revisions

Must click "Submit 
Revisions" for ETD 

Coordinator to 
receive notification

Process repeats 
until you pass

Usually takes a 
couple of rounds
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After You Pass the Format Check 

You will receive a notification email from me notifying you that you have passed the format 
check. Depending on where you are in your writing process and the point of the semester at 
which you pass, you will either receive a preliminary format approval or a final approval.  

Preliminary Format Approval 

To qualify for a preliminary format approval, your document must have at least a completed title 
page, table of contents, chapters, references, and (if needed) appendices. This approval status 
is for students who pass the format check prior to the final submission deadline.  

If you receive preliminary format approval but anticipate making changes to the content, you 
must let the ETD Coordinator know this. Your document will not receive final submission 
approval until the content and the formatting are both finalized, complete, and free of errors.  

A note will be added to your account stating which version has an acceptable format. Your 
coordinator at the Graduate School (whom you can look up at this link) will not be assigned to 
your account at this stage.  

Please note that the preliminary format approval is not a required stage. Whether you receive 
preliminary format approval or final submission approval depends entirely on where you are in 
the writing and formatting process.  

Preliminary Format 
Approval

Has essential parts, 
but may change 

content before final 
submission deadline

Title page, Table of 
Contents

Chapters, References, 
Appendix (if needed)

Before final 
submission deadline

https://www.sc.edu/study/colleges_schools/graduate_school/about_us/graduate_program_coordinators/index.php
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Final Submission Approval 

Your document will receive final submission approval after you: 
1. Pass the format check
2. Have all content finalized and approved by committee.

The document that receives final submission approval is the one that will be published. All 
documents must receive final submission approval for you to remain eligible to graduate.  

Final submission approval requires content clearance from your committee and final format 
approval from the ETD Coordinator.  

After Final Submission Approval 

After you receive final submission approval, the ETD Coordinator will add a note to your account 
specifying which version of your document has passed the format check, and she will assign 
your coordinator at the Graduate School to your account.  

Your coordinator will process your graduation paperwork in its entirety, which can take several 
weeks. Your ETD account may still say “in review,” but that does not mean your ETD has not 
been approved. If you ever have questions about your graduation status after you have received 
final submission approval, you can contact your coordinator.  

Final Submission 
Approval

Complete document No formatting 
errors

Approved by 
committee & ETD 

Coordinator

Usually after final 
submission deadline 

(not always)

https://www.sc.edu/study/colleges_schools/graduate_school/about_us/graduate_program_coordinators/index.php
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Q: Do I have to wait until after I have defended to submit my document for the 
format check?  
A: No, you do not have to wait until after you have defended. You may submit your 
document for the format check prior to your defense. 

Q: How do I submit my document to have the format reviewed? May I email my Word 
file to the Graduate School? 
A: The Graduate School does not accept submissions via email. To submit your document for 
the format check, you must use the ETD Administrator system. Please follow the submission 
instructions on  the Graduate School’s Thesis & Dissertation page. 

Q: After I upload my document, do I have to click the “Submit” button? Does that 
mean that I am submitting the final version? 
A: After uploading your document, you MUST click “Submit” in order to submit it for review. 
Simply creating an account and uploading your file to the system is insufficient. To initiate 
the format review process, you must click “Submit”. 

Q: Can I make changes to my document after the format check deadline? 
A: Yes. The initial version you submit will not be considered the final version, and you 
will have until the final submission deadline to resubmit. 

Q: Can I make changes to my document after the final submission has been accepted? 
A: No. No changes whatsoever may be made to the document after your final submission 
has been accepted. This rule applies to both content changes and format changes. If you 
must make a change after the final submission deadline, then you will be ineligible to 
graduate in the current semester, and the earliest you would be eligible to graduate is the 
following semester. 

Q: Is there a separate submission system or process for the format check and the 
final version?  
A: No, everything is submitted through the same ETD Administrator system. Simply submit 
your final, committee-approved version through the system, and after the final submission 
has been approved, it will be considered the version of record preserved by the university 
forever. 

Q: Am I required to submit a bound copy? 
A: No, you are only required to submit the electronic version as a PDF through the online 
ETD Administrator system. The university does not accept or preserve bound copies. If 
you would like to purchase bound copies, you may choose to do so, but that is an optional 
service and not required by the university. You can order copies either when creating your 
ETD account or from the Russell House Print Shop.  

Q: If I choose to order bound copies, will the version that I upload initially be bound? 
A: No, the version that you upload initially will not be bound. Only the final version the 
university approves will be bound and shipped to you after graduation. 

ETD PROCESS FREQUENTLY ASKED QUESTIONS

https://www.sc.edu/study/colleges_schools/graduate_school/academics/thesis_and_dissertation/
https://www.etdadmin.com/main/home?siteId=145
https://sc.edu/about/offices_and_divisions/communications/services/printing/
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---------------
---------------
---------------
---------------
---------------
---------------
---------------
-------

1” 1” 

1” 

Margins 

Every page of your ETD must be printable on standard 8.5” x 11” paper. Do not include borders 
on your document. Your final document must follow these requirements for margins: 

Portrait Orientation 

1. Left and right margins must be set at 1.25” on every page, including pages containing
footnotes, appendices, charts, graphs, tables, figures, etc.

2. Top margins must be 2” for all pages with a major heading (see the list of major
headings below) and for the first page of each chapter.

3. After the first page of a major section, all other pages must have 1” top margins.

4. Bottom margins must be set at 1” throughout.

All content on every page must fit within these margins, including tables, figures, footnotes, etc. 
For help formatting margins, see the “Useful Tips” section at the end of this guide.  

Landscape Orientation 

You can read more about landscape orientation later in this guide, but here are the margin 
requirements: 

1. Top and bottom margins (long sides) must be 1.25”.

2. Left and right margins (short sides) must be 1”.

3. All content on the landscape page must fit within these margins.

4. For pages with a major heading on a landscape page, use these same margins. You do
not need a 2” top margin on a landscape page with a major heading.

CHAPTER 1 
TITLE 

-----------------
-----------------
-----------------
-----------------
-----------------
 

2”

1.25” 1.25” 
1.25” 1.25” 

GENERAL FORMATTING
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Page Numbers 

Page numbers must be centered 0.5” from the bottom of the page (i.e., in the “footer” of the 
page). There will be two pagination sequences in your document:  

1. A lowercase Roman numeral sequence; and
2. An Arabic numeral sequence.

You must follow these requirements when numbering your pages: 

a) The title page should not display a number, but it should be included in the
pagination sequence.

b) Use lowercase Roman numerals (i, ii, iii, iv, etc.) to number your front matter pages
(Acknowledgements, Dedication, Abstract, etc.).

c) Beginning with the foreword/introduction or the first page of your first chapter, use
Arabic numerals (1, 2, 3, 4, etc.) to number all remaining pages of your document,
including the bibliography and any appendices.

d) This new sequence begins at “1”; do not continue the sequence from your front
matter. You should not start a new numbering sequence for each chapter or section,
but should continue the same sequence for the remainder of the thesis/dissertation.

e) Page numbers on landscape-oriented pages must be in the same location as
numbers on portrait-oriented pages. See the “Useful Tips” section at the end of this
guide for help formatting landscape pages.

f) Use the same font for the page numbers as you use for all other text in your
document.

Line Spacing 

Paragraphs in the front matter sections and in the chapters of your document must be double-
spaced. Refer to your style manual (e.g., APA, MLA, Turabian, etc.) when determining how to 
space things such as block quotes, bibliographic entries, endnotes and footnotes, and so forth. 
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Fonts 

Style 
You may choose one of these fonts for all text in your document: 

 Arial
 Calibri
 Courier New
 Palatino
 Tahoma
 Times New Roman

You can only use one of these fonts for all text in your entire document. This includes 
text/content, page numbers, footnotes, endnotes, figures, tables, entries in the table of contents 
and other front matter, table titles, figure captions—essentially every single piece of writing in 
your entire document can only be in your one chosen font. Do not switch back and forth 
between different fonts.  

Do not use any color besides black. The use of color in illustrations, figures, graphs, etc. is 
permitted, but not for text. Hyperlinks are acceptable.  

ProQuest/UMI requires that all fonts used in your document must be embedded in the final PDF 
you submit. For help embedding fonts, see the “Useful Tips” section at the end of this guide.  

Size 
For text in the body of your document, you must use size 12 font only. This requirement pertains 
to text on the title page, front matter, page numbers, chapters, appendices, figure captions, and 
table titles.  

For headings, you have the option to use either 12- or 14-point font. Either choice is acceptable, 
but you must be consistent.  

For writing and data within your tables, you have the option use sizes between 10- and 12-point 
font. Your tables will need to fit within the required margins, so keep this in mind as you format 
your tables. Your table titles, however, must be in size 12. Figure numbers and captions should 
also be in size 12.  

Paragraphs 

The first line of a new paragraph must be indented; however, you have the option not to indent 
the very first paragraph of a chapter or section.  

Either left-justification or full-justification is acceptable for text in the body of your document; 
however, you should choose one method and use it consistently.  

There should be no skipped lines or added space between paragraphs, above headings, or in 
between sections. The text must run continuously from paragraph to paragraph without large 
blank spaces on the pages.  
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Headings and Subheadings 

The Graduate School does not set any specific standards for the format of chapter titles, major 
headings, or subheadings—except for font size, which must be 12- or 14-point. Students should 
refer to the standards set by their departments’ choice of style manuals.  

Regardless of which style you use, all heading and subheading formatting must be consistent 
throughout your document.  

Example: if you decide to center some major headings in size 14 bold font, then all major 
headings must be centered in size 14 bold font.  

Major Headings 

Major headings are the “titles” at the top of the first page of a chapter or major section. Here is a 
list of major headings: 

 Dedication
 Acknowledgements
 Abstract
 Preface
 Table of Contents
 List of Tables
 List of Figures
 List of Symbols
 List of Abbreviations
 Foreword or Introduction
 Chapter titles
 References (or bibliography, works cited, etc.)
 Appendix titles

Widows and Orphans 

The first or last line of a paragraph, a heading, or a subheading must not be isolated by a page 
break. Such isolated lines are called “widows” or “orphans”, and most word processors can be 
set to prevent them.  
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Tables and Figures 

Placement 

You may choose one of the following options when inserting tables or figures into your 
document: 

1. Embed the table or figure in the text. Do not use text wrapping around the sides of the
item. Text should only appear above and/or below the item. OR

2. Place the table or figure on a separate page immediately following the page where
it is first cited. Do not leave any extra space at the bottom of the preceding page. The
text should run continuously. OR

3. Insert all tables and figures at the end of each chapter. All of the tables should be
placed on consecutive pages, followed by figures. Place the items in the same order to
which they are referred in the text. If your chapter is in manuscript style and has
references, place the tables and figures after the references.

Table Requirements 

 Titles should begin with the word “Table”, followed by the number of the chapter, a
period, and the number of the table. E.g., Table 1.1, Table 1.2, Table 1.3, etc.

 Table numbering should restart for each chapter: Table 1.1, Table 2.1, Table 3.1, Table
3.2, Table 3.3, etc.

 If a table occurs in an appendix, the table number should include the letter assigned to
the appendix as well as a number: Table A.1, Table B.1, Table C.1, Table C.2, etc.

 Every table must have a descriptive title. Titles of tables should appear above the table,
and there should be 1 blank between the title and the top of the table.

Example: 

Table 3.1 A List of Shakespeare Plays Assigned by Grade Level 

Play Grade Level 
Romeo and Juliet 9th grade 

King Lear 10th grade 

Julius Caesar 11th grade 

Hamlet 12th grade 
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 A table title may not consist of more than one sentence or phrase.

 Table titles should be flush left with the left side of the table and not extend beyond the
width of the table.

 Table titles must be in size 12 font. For information within the tables, you can use sizes
10-12 font (in the same font as all other text in your document).

 Tables must fit within the required margins set out previously in this guide.

 Note: do not include typesetting notations in your document (such as “Insert Table 3.4
here”).

Figure Requirements 

 Captions should begin with the word “Figure”, followed by the number of the chapter, a
period, and the number of the figure. E.g., Figure 1.1, Figure 1.2, Figure 1.3, etc.

 Figure numbering should restart for each chapter: Figure 1.1, Figure 2.1, Figure 2.2, etc.

 If a figure occurs in an appendix to the document, the figure number should include the
letter assigned to the appendix: Figure A.1, Figure B.1, Figure B.2, etc.

 Figure captions should appear below figures. There should be 1 blank line in between
the figure and its caption.

Example: 

 Captions should be flush left with the left side of the figure and not extend beyond the
width of the figure.

 Figures must fit within the required margins stated earlier in this guide.

 Do not include typesetting notations in your document (such as “Insert Figure 1.2 here”).

 Figure titles and numbers must be in size 12 font (in the same font as all other text in
your document).

Figure 1.1 University of South 
Carolina Graduate School Logo 
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Endnotes and Footnotes 

You may use either endnotes or footnotes at throughout your document, but not both. If you 
decide to use endnotes or footnotes, you should use your word processing software’s automatic 
function for doing so. Do not insert endnotes or footnotes manually.  

Endnotes • Placed at end of chapter or end of document
• Must be consecutively numbered throughout the document

Footnotes • Placed at bottom or in footer of same page where reference is
made

• Footnote numbering may be either consecutive throughout the
document or restart with each chapter. Either is acceptable.

Please refer to a style manual appropriate to your department or discipline for answers to 
specific style questions not addressed in this guide, such as whether to single-space or double-
space your endnotes and footnotes.  

Landscape-Oriented Pages 

Landscape-oriented pages are limited to pages containing items (e.g. figures, tables, charts, or 
illustrations) which, due to their size and/or shape, must be formatted with the top and bottom of 
the item along the 11” sides of a page. These pages must be formatted such that, when viewing 
the page in portrait orientation, the bottom of the item is toward the right margin.  

The item must also fit within the prescribed margins for a document; in landscape orientation, 
this means that the top and bottom margins (the long edges) of the page must be 1.25 inches, 
while the left and right margins (the short edges) of the page must be 1 inch. These margins 
also apply if a landscape page has a major heading.  

The page number for the landscape-oriented page(s) must be in the same location and 
orientation as page numbers found on all other pages in the document (centered .5” from the 
bottom of the page in portrait orientation). When viewing the page in landscape orientation, this 
means that the page number will be centered half an inch from the left edge of the page, and 
rotated so that the bottom of the page number is toward the left edge of the page. 

Only tables/figures should be placed on landscape pages; no paragraphs should be included on 
a landscape page. For help with landscape-oriented pages, see the “Useful Tips” section at the 
end of this Guide. You may also find an example of a correctly formatted landscape page in the 
Sample dissertation on the Graduate School’s website. 

Figure 1.1 Music Score 

56 

1.25” 

1.25” 

1” 1” 
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Your document must be assembled in the order shown below. The sections designated as 
“required” must be included in your final ETD. You do not have to include sections labeled 
“optional.” 

Order of Document Items 
Portion Item Required vs. 

Optional 
Page Number 

Front Matter Title page Required Roman Numeral 
(ii, iii, iv, etc.) 

Copyright page Optional 

Dedication Optional 

Acknowledgements Optional 

Abstract Required 

Preface Optional 

Table of Contents Required 

List of Tables Required if there are 
4 or more tables 

List of Figures Required if there are 
4 or more figures 

List of Symbols Optional 

List of Abbreviations Optional 

Body of 
Document 

Foreword or Introduction Optional Arabic Numeral 
(1, 2, 3, etc.) 

Chapters Required 

Bibliography (or 
References or Works Cited, 
etc.) 

Required 

Appendix or Appendices Optional 

The title page through the list of abbreviations constitutes the front matter portion of your 
document. The Foreword/Introduction and chapters (and appendices) make up the main body of 
your document. Each of the items in this list has specific formatting instructions, detailed on the 
following pages. See the Graduate School’s website for a sample of a correctly formatted ETD. 

DOCUMENT ORGANIZATION 

https://www.sc.edu/study/colleges_schools/graduate_school/academics/thesis_and_dissertation/formatting_your_thesis_dissertation/index.php
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Title Page 
Your ETD must have a title page. All the content on the title page must be centered on the 
page, both vertically and horizontally. Do not use any bold on the title page. Also, do not include 
a page number on the title page; however, you must “count” the title page in your pagination 
sequence. You must include the following information in this order:  

Title 
The title of your thesis/dissertation must be the first line of text. If your title is more than one line, 
single-space the entire title. The title on your title page must be exactly the same as the title in 
your ETD Administrator account online.  

“By” 
Directly below the title should be a blank line. On the next line, type the word “by” and insert 
another blank line below. 

Your Name 
Next, your name should be on a line by itself. Your name must match across several university 
platforms so that your document can be attributed to you. This means you name must appear 
exactly the same across these platforms: 

1. Self-Service Carolina
2. University records
3. ETD Administrator account
4. Title page

Blank Line 
Insert a blank line after your name. 

Previous Degrees 
Next, you will insert the degree(s) you have previously earned. Write the name of the degree on 
one line, then the university/institution and graduation year on the next line. The entire entry 
should be single spaced, but you must double space in between degrees. Example: 

Bachelor of Arts 
University of Georgia, 2008 

Master of Arts 
University of South Carolina, 2011 

Include each bachelor and higher degree you have previously earned (double-space between 
degrees), listed in chronological order by date received. Do not include the major with the 
degree(s), and do not abbreviate the degree(s).  

If one of your past degrees was a dual degree, list each degree separately; do not group them 
into one entry.  

Solid Line 
Next, insert a solid, horizontal, black line. The line distance should be about half the width of the 
title page centered. Example: 
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Current Degree Information 
The next group of information should focus on the degree for which you are writing the thesis or 
dissertation. You must use the following language (double spaced): 

Submitted in Partial Fulfillment of the Requirements 

For the Degree of [insert degree here] in  

[insert your major here] 

[insert the name of your college (not department)] 

University of South Carolina 

[year of graduation] 

Accepted by: 

[your major professor’s/thesis director’s name], [either Major Professor OR Director of Thesis] 

[committee member’s/reader’s name], [either Committee Member OR Reader] 

[committee member’s/reader’s name], [Committee Member OR Reader] 

[committee member’s/reader’s name], [Committee Member OR Reader] 

Cheryl Addy, Interim Vice Provost and Dean of the Graduate School 

See the Graduate School website’s Programs Offered page for information on your degree, 
college, major, etc. You must use the official language for your degree, and you must spell out 
the full name of the degree—for example, “Doctor of Philosophy”, not “Ph.D.”  

Do not include titles or degrees for your professors’ names (such as “Dr.”, “Prof.”, or “Ph.D.”) or 
any name on the title page, including your own.  

Which Type of ETD Terms to Use 
Master’s Thesis Director of Thesis 

Reader 

Doctoral Dissertation Major Professor 
Committee Member 
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TITLE OF DISSERTATION 

By 

Jane Laura Smith 

Bachelor of Arts 
University of South Carolina, 2006 

Master of Arts 
University of South Carolina, 2011 

Submitted in Partial Fulfillment of the Requirements 

For the Degree of Doctor of Education in  

Curriculum and Instruction 

College of Education 

University of South Carolina 

2021 

Accepted by: 

John Doe, Major Professor 

Sara P. Smith, Committee Member 

Michael K. Jones, Committee Member 

Cheryl Addy, Interim Vice Provost and Dean of the Graduate School 



20 

Contents

TITLE OF THESIS 

By 

Paul Douglas Smith 

Bachelor of Arts 
University of South Carolina, 2019 

Submitted in Partial Fulfillment of the Requirements 

For the Degree of Master of Science in  

Mechanical Engineering 

College of Engineering and Computing 

University of South Carolina 

2021 

Accepted by: 

John L. Doe, Director of Thesis 

Sara P. Smith, Reader 

Cheryl Addy, Interim Vice Provost and Dean of the Graduate School 
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Copyright Page 

Although you are not required to do so, the Graduate School recommends that you include a 
copyright notice with your document. According to U.S. law, your work is protected from the 
moment it is created in a tangible fixed form (including in an electronic form); you do not have to 
publish the work, register the work, or pay any fee in order to have copyright protection. 
Therefore, you may include a copyright notice with your thesis/dissertation even if you have not 
registered it with the U.S. Copyright Office.  

However, there are certain benefits to registration. For more information, visit the U.S. Copyright 
Office online at www.copyright.gov. If you decide to register, you may opt to have UMI file for 
copyright registration on your behalf (for a fee) during the electronic submission process, or you 
may personally register with the U.S. Copyright Office. 

If you decide to include a copyright page, it must be in the following format: 

1. Approximately 2” from the bottom of the page, include the following language:

© Copyright by [insert your name], [year of graduation] 
All Rights Reserved. 

This two-line statement should be single-spaced and horizontally centered on the page. 
There should be no text or content on the page besides this statement.  

2. When inserting your name, type it exactly as it appears on the title page. This page
should be immediately after the title page.

3. The copyright page should contain the lowercase Roman numeral “ii” in the center of the
page, 0.5” from the bottom of the page.

4. If, instead of including an “All Rights Reserved” notice, you would like to release your
thesis/dissertation under some less-restrictive type of license, such as a Creative
Commons license, you should indicate as much on this page. The format of this page
will remain the same, but the language will differ depending on the license you choose.

Dedication and Acknowledgements 

You are not required to include either a dedication or any acknowledgements, but if you decide 
to include either, each must follow these guidelines:  

1. For the dedication, make “Dedication” your major heading, placed at the top of the page
with a 2” top margin. It should be followed by a blank line.

2. For the acknowledgements, make “Acknowledgements” your major heading, placed at
the top of the page with a 2” top margin. It should be followed by a blank line.

3. Next, include the body of your dedication or acknowledgements, double spaced. It
should be fully- or left-justified, depending on the alignment you choose for the body of
your document.

http://www.copyright.gov/


22 

Contents

4. If you included a copyright page, the page number on the dedication page should be
lower-case Roman numeral “iii”, centered at 0.5” from the bottom of the page. If you did
not include a copyright page, the page number should be “ii”. The acknowledgements
page should follow the same sequence.

NOTE: You may not combine these two items into one page. The dedication and the 
acknowledgements are two separate items and must be on separate pages. They are grouped 
here only because the formatting requirements are identical for both pages.  

Abstract 

You are required to include an abstract and must follow these guidelines: 

1. The word “Abstract” should be at the top of the page as a heading, followed by a blank
line. Remember, all pages with headings must have a 2” top margin, while other pages
have only a 1” top margin. Thus, if your abstract continues beyond a single page, the
first page will have a 2” top margin, while the remaining pages will have a 1” top
margin.

2. Next, include the body of your abstract, double-spaced. The body of your abstract may
be left- or fully-justified, and should generally be no longer than 350 words.

3. Regarding pagination, the abstract page should follow in the same lowercase Roman
numeral sequence as the other front matter. For example, if you included a copyright
page, a dedication page, and an acknowledgements page, then “v” should be placed
on your abstract page.

Preface 

A preface is optional, but if you include one, you must follow these requirements: 

1. “Preface” should be at the top of the page, followed by a blank line.

2. Double-space the body of the preface, either left- or fully-justified.

3. The pagination should follow the same lowercase Roman numeral sequence as the
previous pages in your document.
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Table of Contents 

You are required to have a table of contents. Here are the guidelines you must follow: 

1. The heading “Table of Contents” is to be placed at the top of the page, followed by
a blank line. The first page of the table of contents should have a 2” top margin. If
your table of contents is more than one page, only include the heading on the first
page; the remaining pages should have 1” top margins, with no heading.

2. The following items must be listed in your table of contents (if included in your
document):

 Dedication
 Acknowledgements
 Abstract
 Preface
 List of Tables
 List of Figures
 List of Symbols
 List of Abbreviations
 Each chapter, including the chapter number and descriptive title
 Bibliography/references
 Each appendix, including the appendix letter and descriptive title
 Endnotes (if applicable)

3. Do not include the title page, the copyright page, or the table of contents page(s)
in your table of contents.

4. When listing chapter headings and subheadings, do not include more than one
level of subdivision within a chapter; you may list chapter titles only, or chapter
titles and the next level of headings, but none below that. The descriptive chapter
headings and subheadings within the table of contents should match exactly the
language used within the body of your thesis/dissertation itself. Here is an
example:

5. The title of each entry listed in the table of contents should be justified to the left of
the page, along the left margin. However, subheadings below a chapter heading
need to be indented.

Chapter 2: “The Sweetness of Dependence”: Gothic 
  Domination in Edith Wharton’s Summer ..................................... 9 

  2.1 Introduction .......................................................................... 9 

  2.2 Intricacies of Power ............................................................ 17 

  2.3 Violence and Fantasy in Love ............................................ 35 



24 

Contents

6. Page numbers in the table of contents should be along the right margin of the
page (remember, the side margins are 1.25” throughout the document). Include a
leader (a line of dots) in the space between the entry name and the corresponding
page number. See page 23 of this guide for information regarding how to format
leaders in Microsoft Word. Do not simply insert a line of periods with the page
number at the end, because that method will not result in all of the page numbers
being properly aligned on the margin.

7. Double-space between each entry. If an entry takes up more than one line, split
the entry about three-fourths of the way across the page, and place the remaining
text on the next line, single-spaced. Only include a leader from the last line. Here
is an example:

8. The table of contents page(s) should include a page number in lowercase Roman
numerals, in the same sequence as the rest of the front matter.

TABLE OF CONTENTS 

Dedication ............................................................................................. iii 

Abstract ................................................................................................. iv 

List of Tables ......................................................................................... vi 

List of Figures ....................................................................................... vii 

Chapter 1: Introduction ...........................................................................1 

Chapter 2: “Nothing Will Come of Nothing”: Gender 
      Politics in the Father-Daughter Relationship  

  in Shakespeare’s King Lear ............................................................ 32 

Chapter 3: Shakespearean Sonnets and the 
  Legacy of Romeo and Juliet ........................................................... 65 

Chapter 4: Conclusion .......................................................................... 82 

References ........................................................................................... 90 

Appendix A: Images from the Globe Theater ........................................ 97 

Appendix B: First Folio Display Dates ................................................. 101 

v 
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List of Tables 
List of Figures 

If you have fewer than four tables or figures in your document, then you do not need to list them. 
If you have 4 or more, however, then you are required to have a list of tables and/or list of 
figures.  

Note that the list of tables and the list of figures are two separate sections, and they cannot be 
combined. If you include a list of tables and list of figures, they must be on separate pages.  

Here are the requirements, which apply to both the list of figures and list of tables: 

1. The phrase “List of Tables” must be at the top of the page, followed by a blank
line. Use “List of Figures” for the list of figures.

2. The number and title of each table/figure should be aligned on the left margin of
the page. The descriptive title/caption must be included, not just the number.

3. Page numbers in the list should be right-justified. Include a leader between the title
of the table/figure and the corresponding page number. If a title is more than one
line, single- space the entry, and only include a leader from the last line of the title.

4. Double-space between each entry. If an entry takes up more than one line, split
the entry about three-fourths of the way across the page, and place the remaining
text on the next line, single-spaced. Only include a leader from the last line. Here
is an example:

5. The descriptive titles of tables/figures in the list should match exactly the language
used within the body of your thesis/dissertation itself.

6. The page(s) containing the list should include a page number in lowercase Roman
numerals, in the same sequence as the rest of the front matter.

Table 1.1 Uses of Shakespeare’s First 
  Folio in 12th Grade AP English ...................................... 12 

Table 2.1 Reading Comprehension 
      Scales Used in AP English  

  Assessment ................................................................... 35 
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List of Symbols 

A list of symbols is not required, but if you choose to include one, follow these guidelines: 

1. Type “List of Symbols” at the top of the page, then insert a blank line.

2. All the symbols should be left-justified along the left margin.

After typing the symbol, tab over once, then type the definition or description of the
symbol. The beginning of each definition/description should be aligned on the page.

3. Double-space between entries. If a definition/description takes up more than one line,
single-space for that entry, and make sure that each line of text is consistently left- 
aligned.

4. Include the page number in the same lowercase Roman numeral sequence as the other
front matter.

List of Abbreviations 

Including a list of abbreviations is optional. The following format must be followed if you decide 
to include a list of abbreviations: 

1. “List of Abbreviations” is to be placed at the top of the page, followed by a blank line.

2. List the abbreviations alphabetically.

3. The abbreviations should be left-justified along the left margin.

4. The definitions of the abbreviations should be right-justified along the right margin.
Include a leader between the abbreviation and its definition. In rare instances, a
definition may be more than one line; if this occurs, single-space the entry, and right-
justify all lines of text.

5. Double-space between entries.

6. Number this page in the same sequence as the other front matter, in lowercase Roman
numerals.
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Foreword or Introduction 

Your foreword or introduction begins the body of your document. The first page of this section 
should be “1”. From this point forward, all page numbers are in Arabic numerals and run 
consecutively.  

However, a foreword or introduction is not required. You do have the option to make your 
introduction your first chapter (as in “Chapter 1: Introduction” or “Chapter 1: Foreword”). Either 
option is acceptable.  

Note: if you want to include figures or tables in your introduction, then you must make it 
“Chapter 1: Introduction.” This is because you must have a number to use for your table and 
figure numbers (e.g., “Figure 1.1” or “Table 1.1”). You cannot include figures or tables in an 
“Introduction” or “Foreword” because you will not have a number to use for figures and tables. 
Moreover, you cannot use “Table I.1” or “Table F.1” because that will cause confusion with 
appendices, which are assigned letter designations. The bottom line is if you want to insert 
tables or figures into your introduction, then it must be a chapter.  

Chapters 

Here are requirements you must fulfill for your chapters: 

1. From this point forward, number all remaining pages (including the bibliography and
appendices) with Arabic numerals, starting at “1” on the first page of your introduction or
first chapter.

2. Every chapter title must begin with the word “Chapter,” then have the number
designation, then the descriptive title (e.g., “Chapter 1: Introduction” or “Chapter 2:
Literature Review”).

3. All chapter numbers must either be spelled out or written in Arabic numerals, but you
must be consistent (“Chapter One” or “Chapter 1”). You cannot use Roman numerals for
chapter numbers. Choose one style and use it for all chapter titles.

4. Begin each new chapter with the chapter title at the top of a new page with a 2” top
margin. The remaining pages of the chapter will have 1” top margins.

5. The text of the main body may be either left-justified or fully-justified. Whichever you
choose, you must use it consistently throughout the entire document, including with front
matter (Dedication, Abstract, etc.).

6. Each chapter title must be an entry in the table of contents.

7. Each new chapter must begin on a new page. Subsections within chapters should not
start on a new page unless there is no room on the preceding page (remember to avoid
widows/orphans).

8. A conclusion/concluding chapter is optional.
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Bibliography / Works Cited / References 

You are required to have a bibliography at the end of your document. 

If you are using manuscript style and have references at the end of your chapters, you still need 
to include a full, complete bibliography at the end of your document. Do not insert references at 
the end of every single chapter. For manuscript style, only insert references at the end of 
manuscript chapters.  

Here are the requirements for your bibliography: 

1. Consult your approved style manual (e.g., APA, MLA, etc.) for specifics on how to
structure your reference entries. Use the style manual’s requirements consistently.

2. Margins must still adhere to requirements stated previously in this guide.

3. Page numbers will continue to be in order and in Arabic numerals, just like the preceding
pages of the body of your document.

4. Select a major heading appropriate to your discipline and style manual (e.g., “Works
Cited” for MLA, etc.). Place it at the top of the page, using a 2” top margin.

5. Refer to your style manual to determine whether to single or double space your entries.

6. Avoid widows/orphans even in the bibliography.

Appendix or Appendices 

Appendices are optional. The purpose of an appendix is to include additional information that 
does not have an appropriate place in a chapter. Examples of appendix materials include 
surveys, computer programs, or formulas.  

1. Include all appendices after the references section. No appendix should appear directly
after a chapter, even if that appendix only pertains to that chapter.

2. Each appendix must have a letter designation and a descriptive title (e.g, “Appendix A:
Supplementary Tables” or “Appendix B: Permission to Reprint”). Each appendix title is
considered a major heading and must be formatted just like your other major headings.

3. The appendix title must be at the top of the first page with a 2” top margin. All
subsequent pages of the appendix must have 1” top margins.

4. Each appendix must be listed in the table of contents, and all page numbers must be in
Arabic numerals.

5. If you have figures or tables in an appendix, then the figure or table numbers must match
the appendix’s letter. Example: “Figure A.1” for a figure in Appendix A; “Figure B.1” for a
figure in Appendix B.
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Supplementary Files 

If you have supporting files or documents to include with your dissertation, such as sound clips 
or data sets, that will not “fit” into the traditional PDF format of your dissertation, then you can 
submit this information as “supplementary files” in ProQuest.  

These files are not subject to the Graduate School’s formatting requirements. 

These files will accompany your ETD, but will not be in the PDF. If you order a hard copy, you 
will receive a copy of these files as a CD in the back pocket of your book.  

You can read more about this option at ProQuest’s website. 

https://support.proquest.com/articledetail?id=kA23r000000FUaYCAW&key=supplementary%20files&pcat=All__c&icat=
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Some departments may allow you to include, as chapters, articles that have been or will be 
submitted to scholarly journals. This style is also referred to as “manuscript style,” and has been 
approved by the Graduate School for use by all departments. However, you must have the 
approval of your department to use the manuscript style for chapters in your document. 

The format requirements explained previously also apply to manuscript chapters, regardless of 
how the manuscript was previously formatted for submission to a publisher. You are not 
required to change the content of your manuscripts that have been published or prepared for 
publication, but you are required to change the presentation of that content so that it meets the 
Graduate School’s format requirements. This section of the format guide details the 
requirements for using manuscript style. These requirements apply only to manuscript chapters, 
in addition to the requirements described in the previous sections of this format guide. 

Authorship 
You must be either the sole author or the first co-author of each manuscript submitted as a 
manuscript chapter.  

Manuscript with Multiple Authors 
It is acceptable to submit a manuscript that you co-authored with others, but you must be the 
first/primary author. If you are not listed as the first or primary author, then you advisor must 
submit a letter to the Graduate School confirming that you are the primary author of all 
manuscripts you have included in your dissertation. The letter must also state that your 
dissertation contains only your own original work.  

Co-First Authors of Manuscript 
If you and a fellow graduate student are both co-first authors on a manuscript and wish to use it 
in your dissertations, then you must seek approval from both of your committees and from the 
Graduate School. You will need to submit a memo signed by your major professors to the 
Graduate School confirming that you are both co-first authors of the manuscript and that these 
manuscripts are indeed your original work. All requests are subject to the Graduate School’s 
approval.  

Copyright Release 
You must include evidence that you have received permission to use articles which have been 
published or accepted for publication. It is your responsibility to secure copyright releases prior 
to submitting your document to the Graduate School. There is no specific form the evidence 
must take; as long as it is clear that you have permission to re-use the content, that will be 
sufficient.  

Common types of permission include a letter or email from the publisher, a screenshot of the 
publisher’s website explaining your rights as an author, or a printout from the Copyright 
Clearance Center. Your document will not be accepted as a final submission until all necessary 
copyright releases have been received by the Graduate School. The evidence of permission 
should be included within the dissertation itself, not submitted separately. Typically, students 
have done this by inserting the evidence as an appendix to the document labeled “Permission to 
Reprint” or some similar title. 

MANUSCRIPT STYLE: USING JOURNAL ARTICLES AS CHAPTERS
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Overall Document Structure 
The same requirements discussed previously for required vs. optional sections also apply to 
manuscript ETDs. However, there are some additional requirements for manuscript ETDs.  

You must include: 

 Abstract describing the dissertation as a whole

 Introduction or introductory chapter that details the structure of the document

 Literature review that defines the objectives of the research

 Conclusion or concluding chapter that ties together the major results.

Unavoidably, these requirements will duplicate some of the introductory and concluding material 
in each article/chapter.  

With these elements, the dissertation will be presented as a unified product, rather than simply a 
collection of related but separate manuscripts.  

Chapters 
As stated, manuscript style is for material that is intended for publication. If you have multiple 
manuscripts in your document, do not combine all manuscripts into one chapter. Each 
manuscript or article must be in a separate chapter.  

Tables and Figures 
Tables and figures in manuscript chapters must also adhere to the Graduate School’s formatting 
requirements. Do not use the same table/figure numbers that you used in preparation for 
submission to a publisher. Instead, follow the criteria stated earlier in this guide with regard to 
numbering and creating titles and captions.  

Chapter Cover Page 
The names of all authors, in journal-submitted order, and the name of the journal – with volume, 
page numbers, date (if known), and article status (e.g., “to be submitted,” “submitted to,” etc.) – 
must be given as a footnote to the title on the first page of each manuscript chapter. This 
footnote will indicate the current status of each manuscript.  

The text of the journal article may begin on either this first page or on the subsequent page. A 
sample chapter cover page appears on the next page of this guide.  

Note that there are four footnotes on the sample page, showing you the language that you need 
to include based on whether your article has been published, accepted for publication, 
submitted, or to be submitted. Place an appropriate footnote on your cover page, and follow the 
citation format in your chosen style manual. 
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CHAPTER 2 

THE TITLE OF YOUR CHAPTER BELONGS HERE, CENTERED  

AND DOUBLE SPACED, USING THE SAME MAJOR HEADING FORMAT 

YOU USED THROUGHOUT YOUR DOCUMENT1  

1 Sample, I.G. and U.B. Goodwin. To be submitted to Psychology Today. 

1 Sample, I.G. and U.B. Goodwin. Submitted to Psychology Today, 12/10/2017. 

1 Sample, I.G. and U.B. Goodwin, 2017. Psychology Today. 1045:562-603. 
Reprinted here with permission of the publisher, 12/10/2017. 

1 Sample, I.G. and U.B. Goodwin, 2017. Psychology Today. 1045:562-603. 
Reprinted here with permission of the publisher. 
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Templates 
Downloadable templates in MS Word format are available on the Graduate School website. 
There is a full template that contains all sections in one document, and there are also templates 
for individual pages or sections. The templates have been pre-formatted, so that all you need to 
do is enter in your information wherever you find red text in the document (don’t forget to 
change all the red text to black before submitting).  

You are not required to use a template, but if you choose to use any, remember that you still 
need to be familiar with formatting requirements. The templates exist as an additional tool, and 
not as a replacement for the format guide.  

Please note that some content or pages in the templates may or may not be in your document, 
such as the Preface or Dedication. If you decide not to include one or more of the optional 
sections in your document, then you must remove those pages from the template, and adjust 
your Table of Contents and page numbers accordingly.  

Also note that if you use a template, the formatting may be altered as you edit your document. 
For example, the templates have been divided into multiple sections (see the information 
regarding section breaks, below); if you are not careful, you may end up deleting the section 
breaks and throwing off the formatting. Pay attention as you make changes, so that you are 
careful to keep everything where it needs to be. 

One helpful way to keep track of formatting in MS Word is to show the paragraph and formatting 
indicators that are usually hidden. To do this, navigate to the “Home” tab, and click the 
paragraph symbol (¶) in the upper right corner of the “Paragraph” section. This is a useful tool 
because it shows you where invisible things like tabs and section breaks have been inserted. 

Finally, do not use the templates or samples when determining which style to apply in your 
document (such as APA, Chicago, MLA, etc.). As previously mentioned in this guide, you should 
refer to the style manual approved by your department as you write your thesis or dissertation. 
This is especially important for things like in-text citations, footnotes, endnotes, bibliography, 
etc. 

Samples 
The Graduate School website also contains downloadable samples available as PDF files. 
Again, the samples should not be the only thing you consult when creating your document – 
they are provided only as examples of what properly formatted submissions look like. One 
sample contains red text to indicate information that needs to be changed in your document, 
and also contains instructions, reminders, and tips in blue text that are designed to help you 
along. Be aware that your final document must contain only black text; the red and blue text in 
the sample is only a different color to assist you in the preparation of your final document. A 
second sample contains no annotations and is indicative of what a final submission will 
resemble. 

USEFUL TIPS 

https://www.sc.edu/study/colleges_schools/graduate_school/academics/thesis_and_dissertation/formatting_your_thesis_dissertation/preformatted_templates/index.php
https://www.sc.edu/study/colleges_schools/graduate_school/academics/thesis_and_dissertation/formatting_your_thesis_dissertation/index.php
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Formatting Margins 
To change the margins in MS Word 2019 for Windows (your particular operating system or 
software version may have slightly different procedures, though the functionality and process 
will be similar), click the “Layout” tab at the top of the window, then click the “Margins” icon. At 
the bottom of the list, click “Custom Margins” to bring up a dialog box. 

Now, set the margins for the top, bottom, left, and right of the page. The margins will vary, 
depending on whether your page is in portrait or landscape orientation. For landscape 
instructions, see the “Landscape Orientation” section of this guide.  

Portrait Orientation 
Your bottom margins will always be 1”, and your left and right margins will always be 1.25” 
throughout your document, but your top margins will be either 1” or 2”, depending on whether a 
given page has a heading (see the section on General Formatting, above, for specific 
requirements regarding margins).  
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To format different top headings for pages within a single document, use section breaks (see 
the next section of this guide, below, if you need assistance creating sections). Once you have 
adjusted the settings, click “OK” to apply your selections and save your changes. 

Page Breaks and Section Breaks 
When you need to start a new page, do not repeatedly press “Enter” until you get to a new 
page. Instead, insert a page break. This method is preferable because no matter the changes 
that you make above the page break, the text after the page break will always appear on a new 
page.  

To do this in MS Word, make sure that your cursor is at the location in your document where 
you want to insert the page break, then click on the “Insert” tab at the top of the window, and 
then click “Page Break.” You can also hold the “Ctrl” key on your keyboard and press “Enter.” 
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A section break divides the document into sections, each of which can have unique formatting 
settings. By creating new sections, you can more easily format page numbers, landscape 
pages, and even create new sections for pages with major headings. Sections allow you to 
format your document properly without having to sacrifice content.  

To insert a section break in MS Word, navigate to the “Layout” tab at the top of the window, click 
“Breaks”, and then select the appropriate type of section break you want to insert under the 
“Section Breaks” heading. 
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Landscape Orientation 
If you have a large table or figure in your document, it may be necessary to orient one or more 
of your pages in landscape format, meaning the longer sides of the page (11”) are on the top 
and bottom, and the shorter sides (8.5”) are on the left and right. Rather than keeping the page 
in portrait orientation and rotating the content (so that the reader will be forced to turn his/her 
head in order to read the information), you should use the tools in the word processor to rotate 
the page such that the content is readable from left to right on a computer screen. 

To do this in MS Word 2018, first click at the end of the page before you want to begin 
landscape orientation. Insert a “Next Page” section break (see the instructions elsewhere in this 
guide if you need to learn how to insert section breaks).  

Your cursor should now be on a new page; go ahead and create another “Next Page” section 
break so that the entire page is blank. This second “next page” will be where your content on 
portrait-oriented pages continues.  

Now make sure your cursor is in the section you want to change to landscape orientation. On 
the “Layout” tab at the top of the page, click “Orientation” in the “Page Setup” group, and select 
“Landscape.” The page should now be in landscape orientation. 



38 

Contents

With your cursor placed anywhere on the first page of the section with landscape pages, go to 
the “Insert” tab, navigate to the “Header & Footer” group, and click “Header” to bring up a list of 
options; click “Edit Header” near the bottom. 



39 

Contents

MS Word will then provide you with a “Header & Footer” tab. Click on this tab, and make sure 
that “Link to Previous” is not highlighted. Click “Go to Footer” and make sure that “Link to 
Previous” is also not highlighted there before clicking “Close Header and Footer.”  

Next, place your cursor in the first page that is in portrait orientation following the landscape 
page(s), and repeat the process of un-linking to previous sections – make sure that both the 
header and footer do not have “Link to Previous” highlighted. You may now edit the page 
number of the landscape-oriented page(s) without altering the page numbers of other sections. 

Page Numbers in Landscape Orientation 

After switching to landscape orientation, the page number on your landscape-oriented page(s) 
is probably still at the bottom of the page (which should now be the 11” side). You must change 
the page number so that it is in the same position as it is on all the other pages.  

To do this, first delete the page number on the landscape page(s). Then, go to the “Insert” tab, 
navigate to the “Header & Footer” group, and click “Page Number.” In the drop-down list that 
you see, choose “Page Margins,” and click “Large, left” under the “Plain Number” heading. Use 
your mouse to highlight the page number that appears in the box, go to the “Home” tab, and 
change the font type and size to match the rest of your document. 
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Now you will need to rotate the page number so that it is in the proper direction. First, use your 
cursor to highlight the page number.  

In the “Shape Format” format tab at the top of the window, go to the “Text” group and click “Text 
Direction.” Rotate the text 90 degrees such that the bottom of the page number is toward the left 
side of the page. Now, the content is readable on a computer screen, and the page numbers 
are consistent for all pages. 
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Formatting Leaders 

“Leaders” refers to the line of dots you are required to insert in your table of contents, list of 
tables, list of figures, and list of abbreviations. When you need to insert a leader (a line of dots) 
in your document, follow these procedures.  

First, position your cursor in the location where you want the leader to be. Then, go to the 
“Home” tab at the top of the window and click the arrow in the lower right corner of the 
“Paragraph” section. Click the “Tabs…” button at the bottom of the dialog box that appears. This 
will bring up a new dialog box. 
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Clear any tab stops that have already been entered by clicking the “Clear All” button. At the top 
of the dialog box, enter a new tab stop position of 6”. Since your left and right margins must be 
set at 1.25”, a 6” tab stop will ensure that your tab will align on the right margin.  

Under “Alignment,” select “Right,” and under “Leader,” select the second option (a line of dots). 
Next, make sure you click “Set” before clicking “OK.”  

Now, when you insert a tab at that position in your document, it will automatically align on the 
right margin and include a leader from the location you enter the tab. You may also format 
multiple tabs using this interface; to do so, simply type another length in the “Tab stop position” 
field. For instance, if you wanted the first tab on a line to be .5” and the second to be 6”, you 
would first type “.5” in the field, then click “Set,” then type “6” and click “Set” again. Don’t forget 
to adjust the “Alignment” and “Leader” options for each tab stop. 

Creating a Hanging Indent 

For entries longer than one line in your table of contents, list of tables, and list of figures, you will 
need to use a hanging indent. Because you must set up your tabs to use as leaders (lines of 
dots), you will not be able to use the “tab” button to create this indent. However, you can use the 
hanging indent option in MS Word to achieve this effect.  

First, write all entries for your table of contents (or list of tables, list of figures, etc.). Create the 
leaders for each entry and insert the page numbers.  

When you add these entries, go ahead and split the text for entries longer than one line. This 
will ensure there is blank space above the page number, keeping your table of contents (or list 
of tables, list of figures, etc.) easier to read.  
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Then, you will highlight the content you want to indent. Then, right-click the content to bring up 
the “Paragraph” menu. 
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Then, in the indentation section, you will select “Hanging” under special. In the box labeled “by:”, 
you will enter “0.5”. Likewise, you will enter “0.5” in the “Left” box. This will ensure your hanging 
indent is 0.5 inches. Then, click “Ok” to finalize the process.  

After taking these steps, your table of contents should be formatted properly. 

Remember that these steps apply to all entries that are longer than one line in the table of 
contents, list of tables, and list of figures.  
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Embedding Fonts 

ProQuest/UMI requires that all fonts be embedded in your document before you upload it to 
their site. Embedding fonts ensures that the content of your document will be viewable on all 
computers. To embed fonts in MS Word 2010, first click the “File” tab in the top left of the 
window, then click “Options.” In the new dialog box that appears, click “Save” on the left side. At 
the bottom of the window, make sure there is a check in the box beside “Embed fonts in the 
file,” and that there is not a check in the box beside “Do not embed common system fonts.” 

Assembling Your PDF 

The final document that you submit must be in a single PDF file, but there are several ways you 
could create that file. The first is to create a single MS Word file, ensure that all formatting 
requirements have been met, and then convert that file to PDF. You may either convert the MS 
Word file to PDF yourself prior to submission, or you may use the conversion tool on the 
ProQuest/UMI site to convert your MS Word file to PDF. 

However, if you are having trouble with the formatting features of MS Word, it is also possible to 
create multiple files (one for the title page, one for the table of contents, one for the main body, 
etc.), convert each one to PDF, then combine them all into a single PDF using Acrobat Pro or 
some other PDF editing software. If you decide to use this method, you may want to use the 
individual templates for each section (such as title page, abstract, table of contents, etc.) 
provided by the Graduate School. Keep in mind the fact that this method will require you to keep 
track of multiple files and make sure that you have put them all in the correct order before you 
submit. 
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Graduate School Website 
The Graduate School’s website has two pages with detailed information about thesis and 
dissertation requirements, deadlines, processes, workshops, and even an copy of this guide. 

Thesis & Dissertation has general information about ETDs, including a link to ProQuest’s ETD 
site. 

Formatting Your Thesis or Dissertation has more specific information, including templates and 
samples, all of which you can download.  

Electronic Thesis and Dissertation Workshops 
Each semester, the Graduate School hosts several formatting workshops, both in-person and 
virtually. You can read about these workshops and register for them by visiting the Graduate 
School Calendar, the Graduate School’s Thesis & Dissertation page, or the Opportunities Board 
for the university.  

These workshops provide information on thesis and dissertation formatting, the format check 
and submission processes, and useful tips for navigating your ETD account.  

LaTeX Files 
Often, students in the STEM fields choose the LaTeX format because it can accommodate large 
equations while still maintaining the Graduate School’s formatting requirements. You can 
access these files on the Graduate School’s website. This page also has instructions and 
external links to LaTeX distribution options.  

Scholar Commons 
Scholar Commons is the university’s own repository, and it is run by the USC library system. 
Your ETD will be stored in this database, which you can locate through Thomas Cooper 
Library’s database website: https://scholarcommons.sc.edu/.  

ProQuest’s ETD Administrator Help 
If you need help with anything specifically related to ProQuest, such as ordering a hard copy or 
fixing a technical issue with your ETD account, you can contact them directly through this link.  

Order Hard Copy from the Russell House 
You can order a hard copy through ProQuest when you create your ETD account. Another 
option for ordering hard copies of your ETD is to use the Russell House’s print shop. You can 
read about their printing options at this link.  

ADDITIONAL RESOURCES 

https://www.sc.edu/study/colleges_schools/graduate_school/academics/thesis_and_dissertation/index.php
https://www.sc.edu/study/colleges_schools/graduate_school/academics/thesis_and_dissertation/formatting_your_thesis_dissertation/index.php
https://www.sc.edu/study/colleges_schools/graduate_school/about_us/calendar/index.php
https://www.sc.edu/study/colleges_schools/graduate_school/about_us/calendar/index.php
https://www.sc.edu/study/colleges_schools/graduate_school/academics/thesis_and_dissertation/index.php
https://www.sc.edu/study/colleges_schools/graduate_school/opportunities_support/opportunities_bulletin_board/index.php
https://www.sc.edu/study/colleges_schools/graduate_school/academics/thesis_and_dissertation/formatting_your_thesis_dissertation/latex_files/index.php
https://scholarcommons.sc.edu/
https://support.proquest.com/prodhome?pcat=Dissertations__c
https://sc.edu/about/offices_and_divisions/communications/services/printing/
https://support.proquest.com/s/call-us?language=en_US
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	INTRODUCTION 
	INTRODUCTION 
	Figure

	Introduction to the Format Guide 
	 
	Welcome to the University of South Carolina Graduate School format guide for electronic theses and dissertations (ETDs)!  
	 
	This guide provides you with an overview of the format check process; information on embargos, deadlines, and manuscript style; and has meticulous information about how exactly to format your ETD, including formatting requirements, samples, and directions. There is also a section on tips for navigating Microsoft Word, complete with images and alt-text.  
	 
	The purpose of this format guide is to ensure you have access to requirements mandated by the Graduate School. These requirements are not optional, so you do need to follow this guide as you format your ETD.  
	 
	Please note that this guide does not encompass every formatting question possible. Additionally, you should consult your department’s approved style manual for more discipline-specific formatting choices, such as whether to double space footnotes or how to format a bibliographic entry. However, in situations in which there is a conflict between what your style manual instructs and what the format guide states, you must always opt for the format guide’s instructions. This is because your ETD must conform to 
	 
	 
	Why Formatting is Important  
	 
	Formatting may seem trivial, but it is in fact an integral part of your document’s overall presentation. Your thesis or dissertation could contain some of the most important and innovative research in your field, but if it is presented in a sloppy manner—if your fonts don’t match, your margins are skewed, your heading choices are inconsistent, your entries in the table of contents don't match what is in your document—then the brilliance and innovation of your research will be hidden behind a poor presentati
	 
	Moreover, as you progress in your post-graduate career, you will undoubtedly pursue publishing in academic journals or books, or you will apply for grants and research funding. All of these kinds of publications have formatting requirements—requirements that you will be expected to follow in order to be considered acceptable—so it is important to focus on formatting and adhering to requirements.  
	 
	At the Graduate School, we have created formatting requirements that apply to all theses and dissertations equally to ensure your document is formatted properly and consistently. Meeting these requirements is essential not only to graduating, but to guaranteeing your document is able to be read by fellow scholars, meets publishing standards for journals and databases, and, above all, will be presentable and polished enough to ensure your work is taken seriously.  
	  
	 
	DEADLINES 
	DEADLINES 
	Figure

	You must meet three deadlines for your ETD in order to be eligible for graduation. These deadlines are required; if you miss a key deadline, you can jeopardize your graduation eligibility. You can find these specific dates on . 
	the Graduate School’s website

	 
	Table
	TR
	Artifact
	Deadline 
	Deadline 

	Description 
	Description 

	Date(s) 
	Date(s) 


	TR
	Artifact
	Format Check Deadline 
	Format Check Deadline 

	First deadline you must meet. Make your initial submission to review your document. The content does not need to be finalized. You will have the opportunity to revise the content and formatting after this submission.  
	First deadline you must meet. Make your initial submission to review your document. The content does not need to be finalized. You will have the opportunity to revise the content and formatting after this submission.  
	 
	You are encouraged to submit your work for a preliminary format approval ().  
	see page 6 of the format guide

	 

	Early in the  
	Early in the  
	semester  


	TR
	Artifact
	Defense Deadline 
	Defense Deadline 

	If your department requires a defense, this is the deadline by which you must defend your work.  
	If your department requires a defense, this is the deadline by which you must defend your work.  
	 

	Later in semester 
	Later in semester 


	TR
	Artifact
	Final Submission Deadline 
	Final Submission Deadline 
	 

	The deadline by which you must submit your final, most perfect version. You cannot revise content after this date. 
	The deadline by which you must submit your final, most perfect version. You cannot revise content after this date. 
	 

	Near the end of the semester.  
	Near the end of the semester.  



	 
	 
	 
	ETD COORDINATOR CONTACT INFORMATION 
	ETD COORDINATOR CONTACT INFORMATION 
	Figure

	 
	The Electronic Thesis and Dissertation (ETD) Coordinator will review your document for the format check. You can contact this person with any questions about your format check status, formatting concerns, or anything else related to the ETD submission process.  
	 
	ETD Coordinator: Laura Kotti 
	 
	Email:  
	kotti@mailbox.sc.edu

	 
	Phone: 803-777-4244 
	 
	Office: Close-Hipp Building, Suite 552 
	 
	 
	  
	 
	EMBARGO PROCESS AND EMBARGO RENEWALS 
	EMBARGO PROCESS AND EMBARGO RENEWALS 
	Figure

	If you wish to publish any of your work or need to prevent other scholars from viewing or downloading your work, you can request an embargo. This option can keep your work from becoming accessible for an allotted amount of time. Note that work cannot be embargoed permanently. As a public institution, UofSC can only embargo work for a total of 10 years.  
	 
	Embargo Process 
	 
	To request an embargo, you will first need to choose the embargo option on your Dissertation Signature and Approval form () or Master’s Thesis Signature Approval Form (). You can choose an embargo length of 6 months, 1 year, or 2 years. In addition, you are required to submit a letter or memo addressed to the Graduate School that contains the following information: 
	G-DSF
	G-TSF

	 
	 Name of student and your USC ID (9-digit alpha-numeric number) 
	 Name of student and your USC ID (9-digit alpha-numeric number) 
	 Name of student and your USC ID (9-digit alpha-numeric number) 

	 Title of electronic thesis or dissertation (ETD) 
	 Title of electronic thesis or dissertation (ETD) 

	 Justification for embargo 
	 Justification for embargo 

	 Length of embargo (6 months, 1 year, or 2 years) 
	 Length of embargo (6 months, 1 year, or 2 years) 

	 Signature of your major professor and/or head of department 
	 Signature of your major professor and/or head of department 


	 
	Once the Graduate School has received this memo and your G-DSF or G-TSF, your embargo will be processed.  
	 
	Please note that you must select the Delayed Release option in your ProQuest ETD account. If you do not do this, your work will become visible in ProQuest’s databases.  
	 
	Embargo Renewals 
	 
	At the end of your embargo, you have the option to renew. You can renew in an increment of 6 months, 1 year, or 2 years. You are not required to use the same embargo length as before. Altogether, you can embargo your work for a total of 10 years cumulatively, renewing at one of the allotted intervals.  
	 
	Each extension request must be accompanied by a letter from the major professor or department head (if the major professor is no longer at the institution) justifying the extension, and all extensions are subject to approval by the Graduate School.  
	 
	Extension requests must be received by the Graduate School at least thirty days before the expiration of the previous embargo period.  
	 
	It is also important to note that students have a separate agreement with ProQuest/UMI that is not affected by any embargo requests made to the University of South Carolina; likewise, any agreement students have with ProQuest/UMI does not affect their agreement with the University.  
	 
	To renew your embargo with ProQuest, you will need to contact them directly at  or by chat at their website, .  
	disspub@proquest.com
	https://support.proquest.com/chat

	 
	 
	HOW TO SUBMIT YOUR ETD TO THE GRADUATE SCHOOL 
	HOW TO SUBMIT YOUR ETD TO THE GRADUATE SCHOOL 
	Figure

	You will submit your work for the format check through a website called , which is a part of ProQuest/UMI. You can access this link also through the Graduate School’s , clicking on the link that reads “Submit Your Thesis/Dissertation.” 
	ETD Administrator
	website

	 
	Please review and apply all formatting requirements before you submit. The more work your ETD needs, the longer the process will take for you to make revisions. Keep in mind these rules with submitting your ETD for the format check: 
	 
	 No paper submissions are accepted. The entire format check process is electronic. You can only use the ETD Administrator system to submit your work.  
	 No paper submissions are accepted. The entire format check process is electronic. You can only use the ETD Administrator system to submit your work.  
	 No paper submissions are accepted. The entire format check process is electronic. You can only use the ETD Administrator system to submit your work.  


	 
	 The Graduate School does not accept emailed submissions. All submissions must go through the ETD Administrator system.  
	 The Graduate School does not accept emailed submissions. All submissions must go through the ETD Administrator system.  
	 The Graduate School does not accept emailed submissions. All submissions must go through the ETD Administrator system.  


	 
	 When resubmitting your work, continue to use your original account. Do not create a new account when you resubmit. You are only allowed to have one account in the ETD system.  
	 When resubmitting your work, continue to use your original account. Do not create a new account when you resubmit. You are only allowed to have one account in the ETD system.  
	 When resubmitting your work, continue to use your original account. Do not create a new account when you resubmit. You are only allowed to have one account in the ETD system.  


	 
	 The first submission you make is not the version that will be published. The final, accepted version in your account is the one that you will receive as a hard copy and will be published in the appropriate databases.  
	 The first submission you make is not the version that will be published. The final, accepted version in your account is the one that you will receive as a hard copy and will be published in the appropriate databases.  
	 The first submission you make is not the version that will be published. The final, accepted version in your account is the one that you will receive as a hard copy and will be published in the appropriate databases.  


	 
	Submitting for the First Time 
	Table
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	Artifact
	Steps 
	Steps 

	Tips 
	Tips 


	TR
	Artifact
	1. Log in for first time 
	1. Log in for first time 

	This is a new account 
	This is a new account 
	Create password 
	 


	TR
	Artifact
	2. Email addresses 
	2. Email addresses 

	Required to have UofSC email for all format check communication. 
	Required to have UofSC email for all format check communication. 
	Required to have personal email for post-graduation communication with ProQuest. 
	 


	TR
	Artifact
	3. Order hard copies 
	3. Order hard copies 
	 

	Optional, but do this now because it is harder to order copies later. 
	Optional, but do this now because it is harder to order copies later. 
	 


	TR
	Artifact
	4. Enter all ETD information 
	4. Enter all ETD information 

	Must match what is in your  or  
	Must match what is in your  or  
	G-DSF
	G-TSF

	Name must match what is in university records 
	Title must match what is on title page 
	 


	TR
	Artifact
	5. Graduation information 
	5. Graduation information 

	Enter correct graduation month: 
	Enter correct graduation month: 
	 May; or  
	 May; or  
	 May; or  

	 August; or  
	 August; or  

	 December 
	 December 


	 


	TR
	Artifact
	6. Click “Submit” 
	6. Click “Submit” 
	 

	Guarantees ETD Coordinator gains access to your submission 
	Guarantees ETD Coordinator gains access to your submission 
	 



	Format Check Process 
	 
	 
	Diagram
	Figure
	You click "Submit" on first submission

	Figure
	Account is all ready
	Account is all ready


	Figure
	ETD Coordinator receives notification

	Figure
	Only if you hit "submit"!
	Only if you hit "submit"!


	Figure
	ETD Coordinator reviews document

	Figure
	May take several days
	May take several days


	Figure
	ETD Coordinator sends you comments

	Figure
	Goes to your UofSC email address you entered in your ETD account
	Goes to your UofSC email address you entered in your ETD account


	Figure
	You log in to SAME account

	Figure
	Do NOT create a new account!
	Do NOT create a new account!


	Figure
	You submit revisions

	Figure
	Must click "Submit Revisions" for ETD Coordinator to receive notification
	Must click "Submit Revisions" for ETD Coordinator to receive notification


	Figure
	Process repeats until you pass

	Figure
	Usually takes a couple of rounds
	Usually takes a couple of rounds



	 
	After You Pass the Format Check 
	 
	You will receive a notification email from me notifying you that you have passed the format check. Depending on where you are in your writing process and the point of the semester at which you pass, you will either receive a preliminary format approval or a final approval.  
	 
	Preliminary Format Approval 
	 
	Diagram
	Figure
	Preliminary Format Approval

	Figure
	Before final submission deadline

	Figure
	Has essential parts, but may change content before final submission deadline

	Figure
	Title page, Table of Contents

	Figure
	Chapters, References, Appendix (if needed)

	Figure
	Figure
	Figure
	Figure

	To qualify for a preliminary format approval, your document must have at least a completed title page, table of contents, chapters, references, and (if needed) appendices. This approval status is for students who pass the format check prior to the final submission deadline.  
	 
	If you receive preliminary format approval but anticipate making changes to the content, you must let the ETD Coordinator know this. Your document will not receive final submission approval until the content and the formatting are both finalized, complete, and free of errors.  
	 
	A note will be added to your account stating which version has an acceptable format. Your coordinator at the Graduate School (whom you can look up at ) will not be assigned to your account at this stage.  
	this link

	 
	Please note that the preliminary format approval is not a required stage. Whether you receive preliminary format approval or final submission approval depends entirely on where you are in the writing and formatting process.  
	 
	  
	Final Submission Approval 
	 
	Your document will receive final submission approval after you: 
	1. Pass the format check 
	1. Pass the format check 
	1. Pass the format check 

	2. Have all content finalized and approved by committee. 
	2. Have all content finalized and approved by committee. 


	 
	The document that receives final submission approval is the one that will be published. All documents must receive final submission approval for you to remain eligible to graduate.  
	 
	Final submission approval requires content clearance from your committee and final format approval from the ETD Coordinator.  
	 
	 
	Diagram
	Figure
	Final Submission Approval

	Figure
	Usually after final submission deadline (not always)

	Figure
	Complete document

	Figure
	No formatting errors

	Figure
	Approved by committee & ETD Coordinator

	Figure
	Figure
	Figure
	Figure

	 
	After Final Submission Approval 
	 
	After you receive final submission approval, the ETD Coordinator will add a note to your account specifying which version of your document has passed the format check, and she will assign your coordinator at the Graduate School to your account.  
	 
	Your coordinator will process your graduation paperwork in its entirety, which can take several weeks. Your ETD account may still say “in review,” but that does not mean your ETD has not been approved. If you ever have questions about your graduation status after you have received final submission approval, you can .   
	contact your coordinator

	 
	ETD PROCESS FREQUENTLY ASKED QUESTIONS 
	ETD PROCESS FREQUENTLY ASKED QUESTIONS 
	Figure

	 
	Q: Do I have to wait until after I have defended to submit my document for the format check?  
	A: No, you do not have to wait until after you have defended. You may submit your document for the format check prior to your defense. 
	Q: How do I submit my document to have the format reviewed? May I email my Word file to the Graduate School? 
	A: The Graduate School does not accept submissions via email. To submit your document for the format check, you must use the ETD Administrator system. Please follow the submission instructions on  the Graduate School’s . 
	Thesis & Dissertation page

	Q: After I upload my document, do I have to click the “Submit” button? Does that mean that I am submitting the final version? 
	A: After uploading your document, you MUST click “Submit” in order to submit it for review. Simply creating an account and uploading your file to the system is insufficient. To initiate the format review process, you must click “Submit”. 
	Q: Can I make changes to my document after the format check deadline? 
	A: Yes. The initial version you submit will not be considered the final version, and you will have until the final submission deadline to resubmit. 
	Q: Can I make changes to my document after the final submission has been accepted? 
	A: No. No changes whatsoever may be made to the document after your final submission has been accepted. This rule applies to both content changes and format changes. If you must make a change after the final submission deadline, then you will be ineligible to graduate in the current semester, and the earliest you would be eligible to graduate is the following semester. 
	 
	Q: Is there a separate submission system or process for the format check and the final version?  
	A: No, everything is submitted through the same ETD Administrator system. Simply submit your final, committee-approved version through the system, and after the final submission has been approved, it will be considered the version of record preserved by the university forever. 
	Q: Am I required to submit a bound copy? 
	A: No, you are only required to submit the electronic version as a PDF through the online ETD Administrator system. The university does not accept or preserve bound copies. If you would like to purchase bound copies, you may choose to do so, but that is an optional service and not required by the university. You can order copies either when creating your  or from the .  
	ETD account
	Russell House Print Shop

	Q: If I choose to order bound copies, will the version that I upload initially be bound? 
	A: No, the version that you upload initially will not be bound. Only the final version the university approves will be bound and shipped to you after graduation. 
	  
	 
	GENERAL FORMATTING 
	GENERAL FORMATTING 
	Figure

	Margins 
	 
	Every page of your ETD must be printable on standard 8.5” x 11” paper. Do not include borders on your document. Your final document must follow these requirements for margins: 
	 
	Portrait Orientation 
	 
	1. Left and right margins must be set at 1.25” on every page, including pages containing footnotes, appendices, charts, graphs, tables, figures, etc.  
	1. Left and right margins must be set at 1.25” on every page, including pages containing footnotes, appendices, charts, graphs, tables, figures, etc.  
	1. Left and right margins must be set at 1.25” on every page, including pages containing footnotes, appendices, charts, graphs, tables, figures, etc.  


	 
	2. Top margins must be 2” for all pages with a major heading (see the list of major headings below) and for the first page of each chapter.  
	2. Top margins must be 2” for all pages with a major heading (see the list of major headings below) and for the first page of each chapter.  
	2. Top margins must be 2” for all pages with a major heading (see the list of major headings below) and for the first page of each chapter.  


	 
	3. After the first page of a major section, all other pages must have 1” top margins.  
	3. After the first page of a major section, all other pages must have 1” top margins.  
	3. After the first page of a major section, all other pages must have 1” top margins.  


	 
	4. Bottom margins must be set at 1” throughout.  
	4. Bottom margins must be set at 1” throughout.  
	4. Bottom margins must be set at 1” throughout.  


	 
	All content on every page must fit within these margins, including tables, figures, footnotes, etc. For help formatting margins, see the “Useful Tips” section at the end of this guide.  
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	1” 
	Figure

	 
	Figure
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	Figure

	 
	Figure

	TextBox
	2” 
	Figure

	 
	CHAPTER 1 
	CHAPTER 1 
	TITLE 
	------------------------------------------------------------------------------------- 
	Figure

	1” 
	1” 
	Figure

	1” 
	1” 
	Figure

	1.25” 
	1.25” 
	Figure

	1.25” 
	1.25” 
	Figure

	1.25” 
	1.25” 
	Figure

	TextBox
	1.25” 
	Figure

	Figure
	Figure
	Figure
	Figure
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	Landscape Orientation 
	 
	You can read more about landscape orientation later in this guide, but here are the margin requirements: 
	 
	1. Top and bottom margins (long sides) must be 1.25”. 
	1. Top and bottom margins (long sides) must be 1.25”. 
	1. Top and bottom margins (long sides) must be 1.25”. 


	 
	2. Left and right margins (short sides) must be 1”.  
	2. Left and right margins (short sides) must be 1”.  
	2. Left and right margins (short sides) must be 1”.  


	 
	3. All content on the landscape page must fit within these margins.  
	3. All content on the landscape page must fit within these margins.  
	3. All content on the landscape page must fit within these margins.  


	 
	4. For pages with a major heading on a landscape page, use these same margins. You do not need a 2” top margin on a landscape page with a major heading.  
	4. For pages with a major heading on a landscape page, use these same margins. You do not need a 2” top margin on a landscape page with a major heading.  
	4. For pages with a major heading on a landscape page, use these same margins. You do not need a 2” top margin on a landscape page with a major heading.  


	 
	 
	Page Numbers 
	 
	Page numbers must be centered 0.5” from the bottom of the page (i.e., in the “footer” of the page). There will be two pagination sequences in your document:  
	 
	1. A lowercase Roman numeral sequence; and  
	1. A lowercase Roman numeral sequence; and  
	1. A lowercase Roman numeral sequence; and  

	2. An Arabic numeral sequence.  
	2. An Arabic numeral sequence.  


	 
	You must follow these requirements when numbering your pages:  
	 
	a) The title page should not display a number, but it should be included in the pagination sequence.  
	a) The title page should not display a number, but it should be included in the pagination sequence.  
	a) The title page should not display a number, but it should be included in the pagination sequence.  


	 
	b) Use lowercase Roman numerals (i, ii, iii, iv, etc.) to number your front matter pages (Acknowledgements, Dedication, Abstract, etc.).  
	b) Use lowercase Roman numerals (i, ii, iii, iv, etc.) to number your front matter pages (Acknowledgements, Dedication, Abstract, etc.).  
	b) Use lowercase Roman numerals (i, ii, iii, iv, etc.) to number your front matter pages (Acknowledgements, Dedication, Abstract, etc.).  


	 
	c) Beginning with the foreword/introduction or the first page of your first chapter, use Arabic numerals (1, 2, 3, 4, etc.) to number all remaining pages of your document, including the bibliography and any appendices.  
	c) Beginning with the foreword/introduction or the first page of your first chapter, use Arabic numerals (1, 2, 3, 4, etc.) to number all remaining pages of your document, including the bibliography and any appendices.  
	c) Beginning with the foreword/introduction or the first page of your first chapter, use Arabic numerals (1, 2, 3, 4, etc.) to number all remaining pages of your document, including the bibliography and any appendices.  


	 
	d) This new sequence begins at “1”; do not continue the sequence from your front matter. You should not start a new numbering sequence for each chapter or section, but should continue the same sequence for the remainder of the thesis/dissertation.  
	d) This new sequence begins at “1”; do not continue the sequence from your front matter. You should not start a new numbering sequence for each chapter or section, but should continue the same sequence for the remainder of the thesis/dissertation.  
	d) This new sequence begins at “1”; do not continue the sequence from your front matter. You should not start a new numbering sequence for each chapter or section, but should continue the same sequence for the remainder of the thesis/dissertation.  


	 
	e) Page numbers on landscape-oriented pages must be in the same location as numbers on portrait-oriented pages. See the “Useful Tips” section at the end of this guide for help formatting landscape pages.  
	e) Page numbers on landscape-oriented pages must be in the same location as numbers on portrait-oriented pages. See the “Useful Tips” section at the end of this guide for help formatting landscape pages.  
	e) Page numbers on landscape-oriented pages must be in the same location as numbers on portrait-oriented pages. See the “Useful Tips” section at the end of this guide for help formatting landscape pages.  


	 
	f) Use the same font for the page numbers as you use for all other text in your document.  
	f) Use the same font for the page numbers as you use for all other text in your document.  
	f) Use the same font for the page numbers as you use for all other text in your document.  


	 
	  
	Line Spacing 
	 
	Paragraphs in the front matter sections and in the chapters of your document must be double-spaced. Refer to your style manual (e.g., APA, MLA, Turabian, etc.) when determining how to space things such as block quotes, bibliographic entries, endnotes and footnotes, and so forth.  
	 
	 
	  
	Fonts 
	 
	Style 
	You may choose one of these fonts for all text in your document:  
	 
	 Arial 
	 Arial 
	 Arial 

	 Calibri 
	 Calibri 

	 Courier New 
	 Courier New 

	 Palatino 
	 Palatino 

	 Tahoma 
	 Tahoma 

	 Times New Roman 
	 Times New Roman 


	 
	You can only use one of these fonts for all text in your entire document. This includes text/content, page numbers, footnotes, endnotes, figures, tables, entries in the table of contents and other front matter, table titles, figure captions—essentially every single piece of writing in your entire document can only be in your one chosen font. Do not switch back and forth between different fonts.  
	 
	Do not use any color besides black. The use of color in illustrations, figures, graphs, etc. is permitted, but not for text. Hyperlinks are acceptable.  
	 
	ProQuest/UMI requires that all fonts used in your document must be embedded in the final PDF you submit. For help embedding fonts, see the “Useful Tips” section at the end of this guide.  
	 
	Size 
	For text in the body of your document, you must use size 12 font only. This requirement pertains to text on the title page, front matter, page numbers, chapters, appendices, figure captions, and table titles.  
	 
	For headings, you have the option to use either 12- or 14-point font. Either choice is acceptable, but you must be consistent.  
	 
	For writing and data within your tables, you have the option use sizes between 10- and 12-point font. Your tables will need to fit within the required margins, so keep this in mind as you format your tables. Your table titles, however, must be in size 12. Figure numbers and captions should also be in size 12.  
	 
	Paragraphs 
	 
	The first line of a new paragraph must be indented; however, you have the option not to indent the very first paragraph of a chapter or section.  
	 
	Either left-justification or full-justification is acceptable for text in the body of your document; however, you should choose one method and use it consistently.  
	 
	There should be no skipped lines or added space between paragraphs, above headings, or in between sections. The text must run continuously from paragraph to paragraph without large blank spaces on the pages.  
	 
	 
	  
	Headings and Subheadings 
	 
	The Graduate School does not set any specific standards for the format of chapter titles, major headings, or subheadings—except for font size, which must be 12- or 14-point. Students should refer to the standards set by their departments’ choice of style manuals.  
	 
	Regardless of which style you use, all heading and subheading formatting must be consistent throughout your document.  
	 
	Example: if you decide to center some major headings in size 14 bold font, then all major headings must be centered in size 14 bold font.  
	 
	Major Headings 
	 
	Major headings are the “titles” at the top of the first page of a chapter or major section. Here is a list of major headings: 
	 
	 Dedication 
	 Dedication 
	 Dedication 

	 Acknowledgements 
	 Acknowledgements 

	 Abstract 
	 Abstract 

	 Preface 
	 Preface 

	 Table of Contents 
	 Table of Contents 

	 List of Tables 
	 List of Tables 

	 List of Figures 
	 List of Figures 

	 List of Symbols 
	 List of Symbols 

	 List of Abbreviations 
	 List of Abbreviations 

	 Foreword or Introduction 
	 Foreword or Introduction 

	 Chapter titles 
	 Chapter titles 

	 References (or bibliography, works cited, etc.) 
	 References (or bibliography, works cited, etc.) 

	 Appendix titles 
	 Appendix titles 


	 
	 
	Widows and Orphans 
	 
	The first or last line of a paragraph, a heading, or a subheading must not be isolated by a page break. Such isolated lines are called “widows” or “orphans”, and most word processors can be set to prevent them.  
	 
	 
	  
	Tables and Figures 
	 
	Placement 
	 
	You may choose one of the following options when inserting tables or figures into your document: 
	 
	1. Embed the table or figure in the text. Do not use text wrapping around the sides of the item. Text should only appear above and/or below the item. OR 
	1. Embed the table or figure in the text. Do not use text wrapping around the sides of the item. Text should only appear above and/or below the item. OR 
	1. Embed the table or figure in the text. Do not use text wrapping around the sides of the item. Text should only appear above and/or below the item. OR 


	 
	2. Place the table or figure on a separate page immediately following the page where it is first cited. Do not leave any extra space at the bottom of the preceding page. The text should run continuously. OR  
	2. Place the table or figure on a separate page immediately following the page where it is first cited. Do not leave any extra space at the bottom of the preceding page. The text should run continuously. OR  
	2. Place the table or figure on a separate page immediately following the page where it is first cited. Do not leave any extra space at the bottom of the preceding page. The text should run continuously. OR  


	 
	3. Insert all tables and figures at the end of each chapter. All of the tables should be placed on consecutive pages, followed by figures. Place the items in the same order to which they are referred in the text. If your chapter is in manuscript style and has references, place the tables and figures after the references.  
	3. Insert all tables and figures at the end of each chapter. All of the tables should be placed on consecutive pages, followed by figures. Place the items in the same order to which they are referred in the text. If your chapter is in manuscript style and has references, place the tables and figures after the references.  
	3. Insert all tables and figures at the end of each chapter. All of the tables should be placed on consecutive pages, followed by figures. Place the items in the same order to which they are referred in the text. If your chapter is in manuscript style and has references, place the tables and figures after the references.  


	 
	Table Requirements 
	 
	 Titles should begin with the word “Table”, followed by the number of the chapter, a period, and the number of the table. E.g., Table 1.1, Table 1.2, Table 1.3, etc.  
	 Titles should begin with the word “Table”, followed by the number of the chapter, a period, and the number of the table. E.g., Table 1.1, Table 1.2, Table 1.3, etc.  
	 Titles should begin with the word “Table”, followed by the number of the chapter, a period, and the number of the table. E.g., Table 1.1, Table 1.2, Table 1.3, etc.  


	 
	 Table numbering should restart for each chapter: Table 1.1, Table 2.1, Table 3.1, Table 3.2, Table 3.3, etc.  
	 Table numbering should restart for each chapter: Table 1.1, Table 2.1, Table 3.1, Table 3.2, Table 3.3, etc.  
	 Table numbering should restart for each chapter: Table 1.1, Table 2.1, Table 3.1, Table 3.2, Table 3.3, etc.  


	 
	 If a table occurs in an appendix, the table number should include the letter assigned to the appendix as well as a number: Table A.1, Table B.1, Table C.1, Table C.2, etc.  
	 If a table occurs in an appendix, the table number should include the letter assigned to the appendix as well as a number: Table A.1, Table B.1, Table C.1, Table C.2, etc.  
	 If a table occurs in an appendix, the table number should include the letter assigned to the appendix as well as a number: Table A.1, Table B.1, Table C.1, Table C.2, etc.  


	 
	 Every table must have a descriptive title. Titles of tables should appear above the table, and there should be 1 blank between the title and the top of the table.  
	 Every table must have a descriptive title. Titles of tables should appear above the table, and there should be 1 blank between the title and the top of the table.  
	 Every table must have a descriptive title. Titles of tables should appear above the table, and there should be 1 blank between the title and the top of the table.  


	 
	Example: 
	 
	Table 3.1 A List of Shakespeare Plays Assigned by Grade Level 
	 
	Table
	TR
	Artifact
	Play 
	Play 

	Grade Level 
	Grade Level 


	TR
	Artifact
	Romeo and Juliet 
	Romeo and Juliet 
	 

	9th grade 
	9th grade 


	TR
	Artifact
	King Lear 
	King Lear 
	 

	10th grade 
	10th grade 
	 


	TR
	Artifact
	Julius Caesar 
	Julius Caesar 
	 

	11th grade 
	11th grade 


	TR
	Artifact
	Hamlet 
	Hamlet 
	 

	12th grade 
	12th grade 



	 
	  
	 A table title may not consist of more than one sentence or phrase.  
	 A table title may not consist of more than one sentence or phrase.  
	 A table title may not consist of more than one sentence or phrase.  


	 
	 Table titles should be flush left with the left side of the table and not extend beyond the width of the table.  
	 Table titles should be flush left with the left side of the table and not extend beyond the width of the table.  
	 Table titles should be flush left with the left side of the table and not extend beyond the width of the table.  


	 
	 Table titles must be in size 12 font. For information within the tables, you can use sizes 10-12 font (in the same font as all other text in your document).  
	 Table titles must be in size 12 font. For information within the tables, you can use sizes 10-12 font (in the same font as all other text in your document).  
	 Table titles must be in size 12 font. For information within the tables, you can use sizes 10-12 font (in the same font as all other text in your document).  


	 
	 Tables must fit within the required margins set out previously in this guide.  
	 Tables must fit within the required margins set out previously in this guide.  
	 Tables must fit within the required margins set out previously in this guide.  


	 
	 Note: do not include typesetting notations in your document (such as “Insert Table 3.4 here”).  
	 Note: do not include typesetting notations in your document (such as “Insert Table 3.4 here”).  
	 Note: do not include typesetting notations in your document (such as “Insert Table 3.4 here”).  


	 
	 
	Figure Requirements 
	 
	 Captions should begin with the word “Figure”, followed by the number of the chapter, a period, and the number of the figure. E.g., Figure 1.1, Figure 1.2, Figure 1.3, etc. 
	 Captions should begin with the word “Figure”, followed by the number of the chapter, a period, and the number of the figure. E.g., Figure 1.1, Figure 1.2, Figure 1.3, etc. 
	 Captions should begin with the word “Figure”, followed by the number of the chapter, a period, and the number of the figure. E.g., Figure 1.1, Figure 1.2, Figure 1.3, etc. 


	 
	 Figure numbering should restart for each chapter: Figure 1.1, Figure 2.1, Figure 2.2, etc. 
	 Figure numbering should restart for each chapter: Figure 1.1, Figure 2.1, Figure 2.2, etc. 
	 Figure numbering should restart for each chapter: Figure 1.1, Figure 2.1, Figure 2.2, etc. 


	 
	 If a figure occurs in an appendix to the document, the figure number should include the letter assigned to the appendix: Figure A.1, Figure B.1, Figure B.2, etc.  
	 If a figure occurs in an appendix to the document, the figure number should include the letter assigned to the appendix: Figure A.1, Figure B.1, Figure B.2, etc.  
	 If a figure occurs in an appendix to the document, the figure number should include the letter assigned to the appendix: Figure A.1, Figure B.1, Figure B.2, etc.  


	 
	 Figure captions should appear below figures. There should be 1 blank line in between the figure and its caption.  
	 Figure captions should appear below figures. There should be 1 blank line in between the figure and its caption.  
	 Figure captions should appear below figures. There should be 1 blank line in between the figure and its caption.  


	 
	Example: 
	 
	 
	Figure

	 
	Figure 1.1 University of South Carolina Graduate School Logo 
	Figure 1.1 University of South Carolina Graduate School Logo 
	Figure

	 
	 
	 
	 
	 Captions should be flush left with the left side of the figure and not extend beyond the width of the figure.  
	 Captions should be flush left with the left side of the figure and not extend beyond the width of the figure.  
	 Captions should be flush left with the left side of the figure and not extend beyond the width of the figure.  


	 
	 Figures must fit within the required margins stated earlier in this guide.  
	 Figures must fit within the required margins stated earlier in this guide.  
	 Figures must fit within the required margins stated earlier in this guide.  


	 
	 Do not include typesetting notations in your document (such as “Insert Figure 1.2 here”). 
	 Do not include typesetting notations in your document (such as “Insert Figure 1.2 here”). 
	 Do not include typesetting notations in your document (such as “Insert Figure 1.2 here”). 


	 
	 Figure titles and numbers must be in size 12 font (in the same font as all other text in your document). 
	 Figure titles and numbers must be in size 12 font (in the same font as all other text in your document). 
	 Figure titles and numbers must be in size 12 font (in the same font as all other text in your document). 


	Endnotes and Footnotes 
	 
	You may use either endnotes or footnotes at throughout your document, but not both. If you decide to use endnotes or footnotes, you should use your word processing software’s automatic function for doing so. Do not insert endnotes or footnotes manually.  
	 
	Table
	TR
	Artifact
	Endnotes 
	Endnotes 

	• Placed at end of chapter or end of document 
	• Placed at end of chapter or end of document 
	• Placed at end of chapter or end of document 
	• Placed at end of chapter or end of document 

	• Must be consecutively numbered throughout the document 
	• Must be consecutively numbered throughout the document 


	 


	TR
	Artifact
	Footnotes 
	Footnotes 
	 

	• Placed at bottom or in footer of same page where reference is made 
	• Placed at bottom or in footer of same page where reference is made 
	• Placed at bottom or in footer of same page where reference is made 
	• Placed at bottom or in footer of same page where reference is made 

	• Footnote numbering may be either consecutive throughout the document or restart with each chapter. Either is acceptable.  
	• Footnote numbering may be either consecutive throughout the document or restart with each chapter. Either is acceptable.  


	 



	 
	Please refer to a style manual appropriate to your department or discipline for answers to specific style questions not addressed in this guide, such as whether to single-space or double-space your endnotes and footnotes.  
	 
	Landscape-Oriented Pages 
	 
	Landscape-oriented pages are limited to pages containing items (e.g. figures, tables, charts, or illustrations) which, due to their size and/or shape, must be formatted with the top and bottom of the item along the 11” sides of a page. These pages must be formatted such that, when viewing the page in portrait orientation, the bottom of the item is toward the right margin.  
	 
	The item must also fit within the prescribed margins for a document; in landscape orientation, this means that the top and bottom margins (the long edges) of the page must be 1.25 inches, while the left and right margins (the short edges) of the page must be 1 inch. These margins also apply if a landscape page has a major heading.  
	1” 
	1” 
	Figure

	Figure
	56 
	56 
	Figure

	Figure
	1.25” 
	1.25” 
	Figure

	1.25” 
	1.25” 
	Figure

	 
	 
	 
	Figure 1.1 Music Score 
	Figure

	Figure
	1” 
	1” 
	Figure

	 
	The page number for the landscape-oriented page(s) must be in the same location and orientation as page numbers found on all other pages in the document (centered .5” from the bottom of the page in portrait orientation). When viewing the page in landscape orientation, this means that the page number will be centered half an inch from the left edge of the page, and rotated so that the bottom of the page number is toward the left edge of the page. 
	 
	Only tables/figures should be placed on landscape pages; no paragraphs should be included on a landscape page. For help with landscape-oriented pages, see the “Useful Tips” section at the end of this Guide. You may also find an example of a correctly formatted landscape page in the Sample dissertation on the Graduate School’s website. 
	 
	Your document must be assembled in the order shown below. The sections designated as “required” must be included in your final ETD. You do not have to include sections labeled “optional.” 
	DOCUMENT ORGANIZATION 
	DOCUMENT ORGANIZATION 
	Figure

	 
	Order of Document Items 
	Table
	TR
	Artifact
	Portion 
	Portion 

	Item 
	Item 

	Required vs. Optional 
	Required vs. Optional 

	Page Number 
	Page Number 


	TR
	Artifact
	TH
	Artifact
	Front Matter 

	TD
	Artifact
	Title page 

	TD
	Artifact
	Required 
	 

	TD
	Artifact
	Roman Numeral 
	(ii, iii, iv, etc.) 


	TR
	Artifact
	Copyright page 
	Copyright page 

	Optional 
	Optional 
	 


	TR
	Artifact
	TD
	Artifact
	Dedication 

	TD
	Artifact
	Optional 
	 


	TR
	Artifact
	Acknowledgements 
	Acknowledgements 

	Optional 
	Optional 
	 


	TR
	Artifact
	TD
	Artifact
	Abstract 

	TD
	Artifact
	Required 
	 


	TR
	Artifact
	Preface 
	Preface 

	Optional 
	Optional 
	 


	TR
	Artifact
	TD
	Artifact
	Table of Contents 

	TD
	Artifact
	Required 
	 


	TR
	Artifact
	List of Tables 
	List of Tables 
	 

	Required if there are 4 or more tables 
	Required if there are 4 or more tables 
	 


	TR
	Artifact
	TD
	Artifact
	List of Figures 

	TD
	Artifact
	Required if there are 4 or more figures 
	 


	TR
	Artifact
	List of Symbols 
	List of Symbols 
	 

	Optional 
	Optional 
	 


	TR
	Artifact
	TD
	Artifact
	List of Abbreviations 
	 

	TD
	Artifact
	Optional 


	TR
	Artifact
	Body of Document 
	Body of Document 

	Foreword or Introduction 
	Foreword or Introduction 
	 

	Optional 
	Optional 

	Arabic Numeral 
	Arabic Numeral 
	(1, 2, 3, etc.) 


	TR
	Artifact
	TD
	Artifact
	Chapters 
	 

	TD
	Artifact
	Required 


	TR
	Artifact
	Bibliography (or References or Works Cited, etc.) 
	Bibliography (or References or Works Cited, etc.) 

	Required 
	Required 
	 
	 


	TR
	Artifact
	TD
	Artifact
	Appendix or Appendices 
	 

	TD
	Artifact
	Optional 



	 
	The title page through the list of abbreviations constitutes the front matter portion of your document. The Foreword/Introduction and chapters (and appendices) make up the main body of your document. Each of the items in this list has specific formatting instructions, detailed on the following pages. See  for a sample of a correctly formatted ETD. 
	the Graduate School’s website

	  
	Title Page 
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	You are required to include an abstract and must follow these guidelines: 
	 
	1. The word “Abstract” should be at the top of the page as a heading, followed by a blank line. Remember, all pages with headings must have a 2” top margin, while other pages have only a 1” top margin. Thus, if your abstract continues beyond a single page, the first page will have a 2” top margin, while the remaining pages will have a 1” top margin. 
	1. The word “Abstract” should be at the top of the page as a heading, followed by a blank line. Remember, all pages with headings must have a 2” top margin, while other pages have only a 1” top margin. Thus, if your abstract continues beyond a single page, the first page will have a 2” top margin, while the remaining pages will have a 1” top margin. 
	1. The word “Abstract” should be at the top of the page as a heading, followed by a blank line. Remember, all pages with headings must have a 2” top margin, while other pages have only a 1” top margin. Thus, if your abstract continues beyond a single page, the first page will have a 2” top margin, while the remaining pages will have a 1” top margin. 
	1. The word “Abstract” should be at the top of the page as a heading, followed by a blank line. Remember, all pages with headings must have a 2” top margin, while other pages have only a 1” top margin. Thus, if your abstract continues beyond a single page, the first page will have a 2” top margin, while the remaining pages will have a 1” top margin. 



	 
	2. Next, include the body of your abstract, double-spaced. The body of your abstract may be left- or fully-justified, and should generally be no longer than 350 words. 
	2. Next, include the body of your abstract, double-spaced. The body of your abstract may be left- or fully-justified, and should generally be no longer than 350 words. 
	2. Next, include the body of your abstract, double-spaced. The body of your abstract may be left- or fully-justified, and should generally be no longer than 350 words. 
	2. Next, include the body of your abstract, double-spaced. The body of your abstract may be left- or fully-justified, and should generally be no longer than 350 words. 
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	1. “Preface” should be at the top of the page, followed by a blank line. 
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	1. “Preface” should be at the top of the page, followed by a blank line. 
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	1. The heading “Table of Contents” is to be placed at the top of the page, followed by a blank line. The first page of the table of contents should have a 2” top margin. If your table of contents is more than one page, only include the heading on the first page; the remaining pages should have 1” top margins, with no heading. 
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	3. Do not include the title page, the copyright page, or the table of contents page(s) in your table of contents. 
	3. Do not include the title page, the copyright page, or the table of contents page(s) in your table of contents. 
	3. Do not include the title page, the copyright page, or the table of contents page(s) in your table of contents. 


	 
	4. When listing chapter headings and subheadings, do not include more than one level of subdivision within a chapter; you may list chapter titles only, or chapter titles and the next level of headings, but none below that. The descriptive chapter headings and subheadings within the table of contents should match exactly the language used within the body of your thesis/dissertation itself. Here is an example: 
	4. When listing chapter headings and subheadings, do not include more than one level of subdivision within a chapter; you may list chapter titles only, or chapter titles and the next level of headings, but none below that. The descriptive chapter headings and subheadings within the table of contents should match exactly the language used within the body of your thesis/dissertation itself. Here is an example: 
	4. When listing chapter headings and subheadings, do not include more than one level of subdivision within a chapter; you may list chapter titles only, or chapter titles and the next level of headings, but none below that. The descriptive chapter headings and subheadings within the table of contents should match exactly the language used within the body of your thesis/dissertation itself. Here is an example: 
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	5. The title of each entry listed in the table of contents should be justified to the left of the page, along the left margin. However, subheadings below a chapter heading need to be indented. 
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	5. The title of each entry listed in the table of contents should be justified to the left of the page, along the left margin. However, subheadings below a chapter heading need to be indented. 


	  
	6. Page numbers in the table of contents should be along the right margin of the page (remember, the side margins are 1.25” throughout the document). Include a leader (a line of dots) in the space between the entry name and the corresponding page number. See page 23 of this guide for information regarding how to format leaders in Microsoft Word. Do not simply insert a line of periods with the page number at the end, because that method will not result in all of the page numbers being properly aligned on the
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	6. Page numbers in the table of contents should be along the right margin of the page (remember, the side margins are 1.25” throughout the document). Include a leader (a line of dots) in the space between the entry name and the corresponding page number. See page 23 of this guide for information regarding how to format leaders in Microsoft Word. Do not simply insert a line of periods with the page number at the end, because that method will not result in all of the page numbers being properly aligned on the


	 
	7. Double-space between each entry. If an entry takes up more than one line, split the entry about three-fourths of the way across the page, and place the remaining text on the next line, single-spaced. Only include a leader from the last line. Here is an example: 
	7. Double-space between each entry. If an entry takes up more than one line, split the entry about three-fourths of the way across the page, and place the remaining text on the next line, single-spaced. Only include a leader from the last line. Here is an example: 
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	8. The table of contents page(s) should include a page number in lowercase Roman numerals, in the same sequence as the rest of the front matter. 
	8. The table of contents page(s) should include a page number in lowercase Roman numerals, in the same sequence as the rest of the front matter. 
	8. The table of contents page(s) should include a page number in lowercase Roman numerals, in the same sequence as the rest of the front matter. 


	  
	List of Tables 
	List of Figures 
	 
	If you have fewer than four tables or figures in your document, then you do not need to list them. If you have 4 or more, however, then you are required to have a list of tables and/or list of figures.  
	 
	Note that the list of tables and the list of figures are two separate sections, and they cannot be combined. If you include a list of tables and list of figures, they must be on separate pages.  
	 
	Here are the requirements, which apply to both the list of figures and list of tables: 
	 
	1. The phrase “List of Tables” must be at the top of the page, followed by a blank line. Use “List of Figures” for the list of figures. 
	1. The phrase “List of Tables” must be at the top of the page, followed by a blank line. Use “List of Figures” for the list of figures. 
	1. The phrase “List of Tables” must be at the top of the page, followed by a blank line. Use “List of Figures” for the list of figures. 


	 
	2. The number and title of each table/figure should be aligned on the left margin of the page. The descriptive title/caption must be included, not just the number. 
	2. The number and title of each table/figure should be aligned on the left margin of the page. The descriptive title/caption must be included, not just the number. 
	2. The number and title of each table/figure should be aligned on the left margin of the page. The descriptive title/caption must be included, not just the number. 


	 
	3. Page numbers in the list should be right-justified. Include a leader between the title of the table/figure and the corresponding page number. If a title is more than one line, single- space the entry, and only include a leader from the last line of the title. 
	3. Page numbers in the list should be right-justified. Include a leader between the title of the table/figure and the corresponding page number. If a title is more than one line, single- space the entry, and only include a leader from the last line of the title. 
	3. Page numbers in the list should be right-justified. Include a leader between the title of the table/figure and the corresponding page number. If a title is more than one line, single- space the entry, and only include a leader from the last line of the title. 


	 
	4. Double-space between each entry. If an entry takes up more than one line, split the entry about three-fourths of the way across the page, and place the remaining text on the next line, single-spaced. Only include a leader from the last line. Here is an example: 
	4. Double-space between each entry. If an entry takes up more than one line, split the entry about three-fourths of the way across the page, and place the remaining text on the next line, single-spaced. Only include a leader from the last line. Here is an example: 
	4. Double-space between each entry. If an entry takes up more than one line, split the entry about three-fourths of the way across the page, and place the remaining text on the next line, single-spaced. Only include a leader from the last line. Here is an example: 
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	5. The descriptive titles of tables/figures in the list should match exactly the language used within the body of your thesis/dissertation itself. 
	5. The descriptive titles of tables/figures in the list should match exactly the language used within the body of your thesis/dissertation itself. 
	5. The descriptive titles of tables/figures in the list should match exactly the language used within the body of your thesis/dissertation itself. 


	 
	6. The page(s) containing the list should include a page number in lowercase Roman numerals, in the same sequence as the rest of the front matter.  
	6. The page(s) containing the list should include a page number in lowercase Roman numerals, in the same sequence as the rest of the front matter.  
	6. The page(s) containing the list should include a page number in lowercase Roman numerals, in the same sequence as the rest of the front matter.  


	 
	  
	List of Symbols 
	 
	A list of symbols is not required, but if you choose to include one, follow these guidelines: 
	 
	1. Type “List of Symbols” at the top of the page, then insert a blank line. 
	1. Type “List of Symbols” at the top of the page, then insert a blank line. 
	1. Type “List of Symbols” at the top of the page, then insert a blank line. 


	 
	2. All the symbols should be left-justified along the left margin. 
	2. All the symbols should be left-justified along the left margin. 
	2. All the symbols should be left-justified along the left margin. 


	 
	After typing the symbol, tab over once, then type the definition or description of the symbol. The beginning of each definition/description should be aligned on the page. 
	 
	3. Double-space between entries. If a definition/description takes up more than one line, single-space for that entry, and make sure that each line of text is consistently left- aligned. 
	3. Double-space between entries. If a definition/description takes up more than one line, single-space for that entry, and make sure that each line of text is consistently left- aligned. 
	3. Double-space between entries. If a definition/description takes up more than one line, single-space for that entry, and make sure that each line of text is consistently left- aligned. 


	 
	4. Include the page number in the same lowercase Roman numeral sequence as the other front matter. 
	4. Include the page number in the same lowercase Roman numeral sequence as the other front matter. 
	4. Include the page number in the same lowercase Roman numeral sequence as the other front matter. 


	 
	 
	List of Abbreviations 
	 
	Including a list of abbreviations is optional. The following format must be followed if you decide to include a list of abbreviations: 
	 
	1. “List of Abbreviations” is to be placed at the top of the page, followed by a blank line. 
	1. “List of Abbreviations” is to be placed at the top of the page, followed by a blank line. 
	1. “List of Abbreviations” is to be placed at the top of the page, followed by a blank line. 


	 
	2. List the abbreviations alphabetically. 
	2. List the abbreviations alphabetically. 
	2. List the abbreviations alphabetically. 


	 
	3. The abbreviations should be left-justified along the left margin. 
	3. The abbreviations should be left-justified along the left margin. 
	3. The abbreviations should be left-justified along the left margin. 


	 
	4. The definitions of the abbreviations should be right-justified along the right margin. Include a leader between the abbreviation and its definition. In rare instances, a definition may be more than one line; if this occurs, single-space the entry, and right-justify all lines of text. 
	4. The definitions of the abbreviations should be right-justified along the right margin. Include a leader between the abbreviation and its definition. In rare instances, a definition may be more than one line; if this occurs, single-space the entry, and right-justify all lines of text. 
	4. The definitions of the abbreviations should be right-justified along the right margin. Include a leader between the abbreviation and its definition. In rare instances, a definition may be more than one line; if this occurs, single-space the entry, and right-justify all lines of text. 


	 
	5. Double-space between entries. 
	5. Double-space between entries. 
	5. Double-space between entries. 


	 
	6. Number this page in the same sequence as the other front matter, in lowercase Roman numerals. 
	6. Number this page in the same sequence as the other front matter, in lowercase Roman numerals. 
	6. Number this page in the same sequence as the other front matter, in lowercase Roman numerals. 


	 
	  
	Foreword or Introduction 
	 
	Your foreword or introduction begins the body of your document. The first page of this section should be “1”. From this point forward, all page numbers are in Arabic numerals and run consecutively.  
	 
	However, a foreword or introduction is not required. You do have the option to make your introduction your first chapter (as in “Chapter 1: Introduction” or “Chapter 1: Foreword”). Either option is acceptable.  
	 
	Note: if you want to include figures or tables in your introduction, then you must make it “Chapter 1: Introduction.” This is because you must have a number to use for your table and figure numbers (e.g., “Figure 1.1” or “Table 1.1”). You cannot include figures or tables in an “Introduction” or “Foreword” because you will not have a number to use for figures and tables. Moreover, you cannot use “Table I.1” or “Table F.1” because that will cause confusion with appendices, which are assigned letter designatio
	 
	 
	Chapters 
	 
	Here are requirements you must fulfill for your chapters: 
	 
	1. From this point forward, number all remaining pages (including the bibliography and appendices) with Arabic numerals, starting at “1” on the first page of your introduction or first chapter.  
	1. From this point forward, number all remaining pages (including the bibliography and appendices) with Arabic numerals, starting at “1” on the first page of your introduction or first chapter.  
	1. From this point forward, number all remaining pages (including the bibliography and appendices) with Arabic numerals, starting at “1” on the first page of your introduction or first chapter.  


	 
	2. Every chapter title must begin with the word “Chapter,” then have the number designation, then the descriptive title (e.g., “Chapter 1: Introduction” or “Chapter 2: Literature Review”).  
	2. Every chapter title must begin with the word “Chapter,” then have the number designation, then the descriptive title (e.g., “Chapter 1: Introduction” or “Chapter 2: Literature Review”).  
	2. Every chapter title must begin with the word “Chapter,” then have the number designation, then the descriptive title (e.g., “Chapter 1: Introduction” or “Chapter 2: Literature Review”).  


	 
	3. All chapter numbers must either be spelled out or written in Arabic numerals, but you must be consistent (“Chapter One” or “Chapter 1”). You cannot use Roman numerals for chapter numbers. Choose one style and use it for all chapter titles.  
	3. All chapter numbers must either be spelled out or written in Arabic numerals, but you must be consistent (“Chapter One” or “Chapter 1”). You cannot use Roman numerals for chapter numbers. Choose one style and use it for all chapter titles.  
	3. All chapter numbers must either be spelled out or written in Arabic numerals, but you must be consistent (“Chapter One” or “Chapter 1”). You cannot use Roman numerals for chapter numbers. Choose one style and use it for all chapter titles.  


	 
	4. Begin each new chapter with the chapter title at the top of a new page with a 2” top margin. The remaining pages of the chapter will have 1” top margins.  
	4. Begin each new chapter with the chapter title at the top of a new page with a 2” top margin. The remaining pages of the chapter will have 1” top margins.  
	4. Begin each new chapter with the chapter title at the top of a new page with a 2” top margin. The remaining pages of the chapter will have 1” top margins.  


	 
	5. The text of the main body may be either left-justified or fully-justified. Whichever you choose, you must use it consistently throughout the entire document, including with front matter (Dedication, Abstract, etc.).  
	5. The text of the main body may be either left-justified or fully-justified. Whichever you choose, you must use it consistently throughout the entire document, including with front matter (Dedication, Abstract, etc.).  
	5. The text of the main body may be either left-justified or fully-justified. Whichever you choose, you must use it consistently throughout the entire document, including with front matter (Dedication, Abstract, etc.).  


	 
	6. Each chapter title must be an entry in the table of contents.  
	6. Each chapter title must be an entry in the table of contents.  
	6. Each chapter title must be an entry in the table of contents.  


	 
	7. Each new chapter must begin on a new page. Subsections within chapters should not start on a new page unless there is no room on the preceding page (remember to avoid widows/orphans).  
	7. Each new chapter must begin on a new page. Subsections within chapters should not start on a new page unless there is no room on the preceding page (remember to avoid widows/orphans).  
	7. Each new chapter must begin on a new page. Subsections within chapters should not start on a new page unless there is no room on the preceding page (remember to avoid widows/orphans).  


	 
	8. A conclusion/concluding chapter is optional.  
	8. A conclusion/concluding chapter is optional.  
	8. A conclusion/concluding chapter is optional.  


	  
	Bibliography / Works Cited / References 
	 
	You are required to have a bibliography at the end of your document.  
	 
	If you are using manuscript style and have references at the end of your chapters, you still need to include a full, complete bibliography at the end of your document. Do not insert references at the end of every single chapter. For manuscript style, only insert references at the end of manuscript chapters.  
	 
	Here are the requirements for your bibliography: 
	 
	1. Consult your approved style manual (e.g., APA, MLA, etc.) for specifics on how to structure your reference entries. Use the style manual’s requirements consistently.  
	1. Consult your approved style manual (e.g., APA, MLA, etc.) for specifics on how to structure your reference entries. Use the style manual’s requirements consistently.  
	1. Consult your approved style manual (e.g., APA, MLA, etc.) for specifics on how to structure your reference entries. Use the style manual’s requirements consistently.  


	 
	2. Margins must still adhere to requirements stated previously in this guide.  
	2. Margins must still adhere to requirements stated previously in this guide.  
	2. Margins must still adhere to requirements stated previously in this guide.  


	 
	3. Page numbers will continue to be in order and in Arabic numerals, just like the preceding pages of the body of your document.  
	3. Page numbers will continue to be in order and in Arabic numerals, just like the preceding pages of the body of your document.  
	3. Page numbers will continue to be in order and in Arabic numerals, just like the preceding pages of the body of your document.  


	 
	4. Select a major heading appropriate to your discipline and style manual (e.g., “Works Cited” for MLA, etc.). Place it at the top of the page, using a 2” top margin.  
	4. Select a major heading appropriate to your discipline and style manual (e.g., “Works Cited” for MLA, etc.). Place it at the top of the page, using a 2” top margin.  
	4. Select a major heading appropriate to your discipline and style manual (e.g., “Works Cited” for MLA, etc.). Place it at the top of the page, using a 2” top margin.  


	 
	5. Refer to your style manual to determine whether to single or double space your entries.  
	5. Refer to your style manual to determine whether to single or double space your entries.  
	5. Refer to your style manual to determine whether to single or double space your entries.  


	 
	6. Avoid widows/orphans even in the bibliography.  
	6. Avoid widows/orphans even in the bibliography.  
	6. Avoid widows/orphans even in the bibliography.  


	 
	 
	Appendix or Appendices 
	 
	Appendices are optional. The purpose of an appendix is to include additional information that does not have an appropriate place in a chapter. Examples of appendix materials include surveys, computer programs, or formulas.  
	 
	1. Include all appendices after the references section. No appendix should appear directly after a chapter, even if that appendix only pertains to that chapter.  
	1. Include all appendices after the references section. No appendix should appear directly after a chapter, even if that appendix only pertains to that chapter.  
	1. Include all appendices after the references section. No appendix should appear directly after a chapter, even if that appendix only pertains to that chapter.  


	 
	2. Each appendix must have a letter designation and a descriptive title (e.g, “Appendix A: Supplementary Tables” or “Appendix B: Permission to Reprint”). Each appendix title is considered a major heading and must be formatted just like your other major headings.  
	2. Each appendix must have a letter designation and a descriptive title (e.g, “Appendix A: Supplementary Tables” or “Appendix B: Permission to Reprint”). Each appendix title is considered a major heading and must be formatted just like your other major headings.  
	2. Each appendix must have a letter designation and a descriptive title (e.g, “Appendix A: Supplementary Tables” or “Appendix B: Permission to Reprint”). Each appendix title is considered a major heading and must be formatted just like your other major headings.  


	 
	3. The appendix title must be at the top of the first page with a 2” top margin. All subsequent pages of the appendix must have 1” top margins.  
	3. The appendix title must be at the top of the first page with a 2” top margin. All subsequent pages of the appendix must have 1” top margins.  
	3. The appendix title must be at the top of the first page with a 2” top margin. All subsequent pages of the appendix must have 1” top margins.  


	 
	4. Each appendix must be listed in the table of contents, and all page numbers must be in Arabic numerals.  
	4. Each appendix must be listed in the table of contents, and all page numbers must be in Arabic numerals.  
	4. Each appendix must be listed in the table of contents, and all page numbers must be in Arabic numerals.  


	 
	5. If you have figures or tables in an appendix, then the figure or table numbers must match the appendix’s letter. Example: “Figure A.1” for a figure in Appendix A; “Figure B.1” for a figure in Appendix B. 
	5. If you have figures or tables in an appendix, then the figure or table numbers must match the appendix’s letter. Example: “Figure A.1” for a figure in Appendix A; “Figure B.1” for a figure in Appendix B. 
	5. If you have figures or tables in an appendix, then the figure or table numbers must match the appendix’s letter. Example: “Figure A.1” for a figure in Appendix A; “Figure B.1” for a figure in Appendix B. 


	 
	 
	Supplementary Files 
	 
	If you have supporting files or documents to include with your dissertation, such as sound clips or data sets, that will not “fit” into the traditional PDF format of your dissertation, then you can submit this information as “supplementary files” in ProQuest.  
	 
	These files are not subject to the Graduate School’s formatting requirements.  
	 
	These files will accompany your ETD, but will not be in the PDF. If you order a hard copy, you will receive a copy of these files as a CD in the back pocket of your book.  
	 
	You can read more about this option at .  
	ProQuest’s website

	  
	 
	MANUSCRIPT STYLE: USING JOURNAL ARTICLES AS CHAPTERS 
	MANUSCRIPT STYLE: USING JOURNAL ARTICLES AS CHAPTERS 
	Figure

	Some departments may allow you to include, as chapters, articles that have been or will be submitted to scholarly journals. This style is also referred to as “manuscript style,” and has been approved by the Graduate School for use by all departments. However, you must have the approval of your department to use the manuscript style for chapters in your document. 
	 
	The format requirements explained previously also apply to manuscript chapters, regardless of how the manuscript was previously formatted for submission to a publisher. You are not required to change the content of your manuscripts that have been published or prepared for publication, but you are required to change the presentation of that content so that it meets the Graduate School’s format requirements. This section of the format guide details the requirements for using manuscript style. These requiremen
	 
	Authorship 
	You must be either the sole author or the first co-author of each manuscript submitted as a manuscript chapter.  
	 
	Manuscript with Multiple Authors 
	It is acceptable to submit a manuscript that you co-authored with others, but you must be the first/primary author. If you are not listed as the first or primary author, then you advisor must submit a letter to the Graduate School confirming that you are the primary author of all manuscripts you have included in your dissertation. The letter must also state that your dissertation contains only your own original work.  
	 
	Co-First Authors of Manuscript 
	If you and a fellow graduate student are both co-first authors on a manuscript and wish to use it in your dissertations, then you must seek approval from both of your committees and from the Graduate School. You will need to submit a memo signed by your major professors to the Graduate School confirming that you are both co-first authors of the manuscript and that these manuscripts are indeed your original work. All requests are subject to the Graduate School’s approval.  
	 
	 
	Copyright Release 
	You must include evidence that you have received permission to use articles which have been published or accepted for publication. It is your responsibility to secure copyright releases prior to submitting your document to the Graduate School. There is no specific form the evidence must take; as long as it is clear that you have permission to re-use the content, that will be sufficient.  
	 
	Common types of permission include a letter or email from the publisher, a screenshot of the publisher’s website explaining your rights as an author, or a printout from the Copyright Clearance Center. Your document will not be accepted as a final submission until all necessary copyright releases have been received by the Graduate School. The evidence of permission should be included within the dissertation itself, not submitted separately. Typically, students have done this by inserting the evidence as an a
	Overall Document Structure 
	The same requirements discussed previously for required vs. optional sections also apply to manuscript ETDs. However, there are some additional requirements for manuscript ETDs.  
	 
	You must include: 
	 
	 Abstract describing the dissertation as a whole 
	 Abstract describing the dissertation as a whole 
	 Abstract describing the dissertation as a whole 


	 
	 Introduction or introductory chapter that details the structure of the document 
	 Introduction or introductory chapter that details the structure of the document 
	 Introduction or introductory chapter that details the structure of the document 


	 
	 Literature review that defines the objectives of the research 
	 Literature review that defines the objectives of the research 
	 Literature review that defines the objectives of the research 


	 
	 Conclusion or concluding chapter that ties together the major results.  
	 Conclusion or concluding chapter that ties together the major results.  
	 Conclusion or concluding chapter that ties together the major results.  


	 
	Unavoidably, these requirements will duplicate some of the introductory and concluding material in each article/chapter.  
	 
	With these elements, the dissertation will be presented as a unified product, rather than simply a collection of related but separate manuscripts.  
	 
	 
	Chapters 
	As stated, manuscript style is for material that is intended for publication. If you have multiple manuscripts in your document, do not combine all manuscripts into one chapter. Each manuscript or article must be in a separate chapter.  
	 
	 
	Tables and Figures 
	Tables and figures in manuscript chapters must also adhere to the Graduate School’s formatting requirements. Do not use the same table/figure numbers that you used in preparation for submission to a publisher. Instead, follow the criteria stated earlier in this guide with regard to numbering and creating titles and captions.  
	 
	 
	Chapter Cover Page 
	The names of all authors, in journal-submitted order, and the name of the journal – with volume, page numbers, date (if known), and article status (e.g., “to be submitted,” “submitted to,” etc.) – must be given as a footnote to the title on the first page of each manuscript chapter. This footnote will indicate the current status of each manuscript.  
	 
	The text of the journal article may begin on either this first page or on the subsequent page. A sample chapter cover page appears on the next page of this guide.  
	 
	Note that there are four footnotes on the sample page, showing you the language that you need to include based on whether your article has been published, accepted for publication, submitted, or to be submitted. Place an appropriate footnote on your cover page, and follow the citation format in your chosen style manual. 
	  
	 
	 
	 
	 
	 
	CHAPTER 2 
	 
	 
	THE TITLE OF YOUR CHAPTER BELONGS HERE, CENTERED  
	 
	AND DOUBLE SPACED, USING THE SAME MAJOR HEADING FORMAT  
	 
	YOU USED THROUGHOUT YOUR DOCUMENT  
	1

	Figure
	TextBox
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	Figure
	1 Sample, I.G. and U.B. Goodwin. To be submitted to Psychology Today. 
	1 Sample, I.G. and U.B. Goodwin. To be submitted to Psychology Today. 
	 
	1 Sample, I.G. and U.B. Goodwin. Submitted to Psychology Today, 12/10/2017.  
	 
	1 Sample, I.G. and U.B. Goodwin, 2017. Psychology Today. 1045:562-603.  
	 Reprinted here with permission of the publisher, 12/10/2017. 
	 
	1 Sample, I.G. and U.B. Goodwin, 2017. Psychology Today. 1045:562-603.  
	 Reprinted here with permission of the publisher.  
	 
	 
	 
	 

	 
	  
	 
	USEFUL TIPS 
	USEFUL TIPS 
	Figure

	Templates 
	Downloadable templates in MS Word format are available on the . There is a full template that contains all sections in one document, and there are also templates for individual pages or sections. The templates have been pre-formatted, so that all you need to do is enter in your information wherever you find red text in the document (don’t forget to change all the red text to black before submitting).  
	Graduate School website

	 
	You are not required to use a template, but if you choose to use any, remember that you still need to be familiar with formatting requirements. The templates exist as an additional tool, and not as a replacement for the format guide.  
	 
	Please note that some content or pages in the templates may or may not be in your document, such as the Preface or Dedication. If you decide not to include one or more of the optional sections in your document, then you must remove those pages from the template, and adjust your Table of Contents and page numbers accordingly.  
	 
	Also note that if you use a template, the formatting may be altered as you edit your document. For example, the templates have been divided into multiple sections (see the information regarding section breaks, below); if you are not careful, you may end up deleting the section breaks and throwing off the formatting. Pay attention as you make changes, so that you are careful to keep everything where it needs to be. 
	 
	One helpful way to keep track of formatting in MS Word is to show the paragraph and formatting indicators that are usually hidden. To do this, navigate to the “Home” tab, and click the paragraph symbol (¶) in the upper right corner of the “Paragraph” section. This is a useful tool because it shows you where invisible things like tabs and section breaks have been inserted. 
	 
	Finally, do not use the templates or samples when determining which style to apply in your document (such as APA, Chicago, MLA, etc.). As previously mentioned in this guide, you should refer to the style manual approved by your department as you write your thesis or dissertation. This is especially important for things like in-text citations, footnotes, endnotes, bibliography, etc. 
	 
	 
	Samples 
	The Graduate School website also contains . Again, the samples should not be the only thing you consult when creating your document – they are provided only as examples of what properly formatted submissions look like. One sample contains red text to indicate information that needs to be changed in your document, and also contains instructions, reminders, and tips in blue text that are designed to help you along. Be aware that your final document must contain only black text; the red and blue text in the sa
	downloadable samples available as PDF files

	  
	Formatting Margins 
	To change the margins in MS Word 2019 for Windows (your particular operating system or software version may have slightly different procedures, though the functionality and process will be similar), click the “Layout” tab at the top of the window, then click the “Margins” icon. At the bottom of the list, click “Custom Margins” to bring up a dialog box. 
	 
	 
	Figure
	Figure

	 
	Now, set the margins for the top, bottom, left, and right of the page. The margins will vary, depending on whether your page is in portrait or landscape orientation. For landscape instructions, see the “Landscape Orientation” section of this guide.  
	 
	Portrait Orientation 
	Your bottom margins will always be 1”, and your left and right margins will always be 1.25” throughout your document, but your top margins will be either 1” or 2”, depending on whether a given page has a heading (see the section on General Formatting, above, for specific requirements regarding margins).  
	 
	  
	To format different top headings for pages within a single document, use section breaks (see the next section of this guide, below, if you need assistance creating sections). Once you have adjusted the settings, click “OK” to apply your selections and save your changes. 
	 
	 
	Figure
	Figure

	 
	Page Breaks and Section Breaks 
	When you need to start a new page, do not repeatedly press “Enter” until you get to a new page. Instead, insert a page break. This method is preferable because no matter the changes that you make above the page break, the text after the page break will always appear on a new page.  
	 
	To do this in MS Word, make sure that your cursor is at the location in your document where you want to insert the page break, then click on the “Insert” tab at the top of the window, and then click “Page Break.” You can also hold the “Ctrl” key on your keyboard and press “Enter.” 
	 
	  
	Figure
	Figure

	A section break divides the document into sections, each of which can have unique formatting settings. By creating new sections, you can more easily format page numbers, landscape pages, and even create new sections for pages with major headings. Sections allow you to format your document properly without having to sacrifice content.  
	 
	To insert a section break in MS Word, navigate to the “Layout” tab at the top of the window, click “Breaks”, and then select the appropriate type of section break you want to insert under the “Section Breaks” heading. 
	 
	 
	Figure

	 
	 
	 
	 
	 
	 
	  
	Landscape Orientation 
	If you have a large table or figure in your document, it may be necessary to orient one or more of your pages in landscape format, meaning the longer sides of the page (11”) are on the top and bottom, and the shorter sides (8.5”) are on the left and right. Rather than keeping the page in portrait orientation and rotating the content (so that the reader will be forced to turn his/her head in order to read the information), you should use the tools in the word processor to rotate the page such that the conten
	 
	To do this in MS Word 2018, first click at the end of the page before you want to begin landscape orientation. Insert a “Next Page” section break (see the instructions elsewhere in this guide if you need to learn how to insert section breaks).  
	 
	Your cursor should now be on a new page; go ahead and create another “Next Page” section break so that the entire page is blank. This second “next page” will be where your content on portrait-oriented pages continues.  
	 
	Now make sure your cursor is in the section you want to change to landscape orientation. On the “Layout” tab at the top of the page, click “Orientation” in the “Page Setup” group, and select “Landscape.” The page should now be in landscape orientation. 
	 
	 
	Figure
	Figure

	 
	  
	With your cursor placed anywhere on the first page of the section with landscape pages, go to the “Insert” tab, navigate to the “Header & Footer” group, and click “Header” to bring up a list of options; click “Edit Header” near the bottom. 
	 
	 
	Figure

	Figure
	 
	  
	MS Word will then provide you with a “Header & Footer” tab. Click on this tab, and make sure that “Link to Previous” is not highlighted. Click “Go to Footer” and make sure that “Link to Previous” is also not highlighted there before clicking “Close Header and Footer.”  
	 
	 
	Figure
	Figure

	 
	Next, place your cursor in the first page that is in portrait orientation following the landscape page(s), and repeat the process of un-linking to previous sections – make sure that both the header and footer do not have “Link to Previous” highlighted. You may now edit the page number of the landscape-oriented page(s) without altering the page numbers of other sections.  
	 
	 
	Page Numbers in Landscape Orientation 
	 
	After switching to landscape orientation, the page number on your landscape-oriented page(s) is probably still at the bottom of the page (which should now be the 11” side). You must change the page number so that it is in the same position as it is on all the other pages.  
	 
	To do this, first delete the page number on the landscape page(s). Then, go to the “Insert” tab, navigate to the “Header & Footer” group, and click “Page Number.” In the drop-down list that you see, choose “Page Margins,” and click “Large, left” under the “Plain Number” heading. Use your mouse to highlight the page number that appears in the box, go to the “Home” tab, and change the font type and size to match the rest of your document. 
	 
	 
	Figure
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	Figure
	 
	 
	Figure

	 
	Now you will need to rotate the page number so that it is in the proper direction. First, use your cursor to highlight the page number.  
	 
	In the “Shape Format” format tab at the top of the window, go to the “Text” group and click “Text Direction.” Rotate the text 90 degrees such that the bottom of the page number is toward the left side of the page. Now, the content is readable on a computer screen, and the page numbers are consistent for all pages. 
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	Figure
	 
	Formatting Leaders 
	 
	“Leaders” refers to the line of dots you are required to insert in your table of contents, list of tables, list of figures, and list of abbreviations. When you need to insert a leader (a line of dots) in your document, follow these procedures.  
	 
	First, position your cursor in the location where you want the leader to be. Then, go to the “Home” tab at the top of the window and click the arrow in the lower right corner of the “Paragraph” section. Click the “Tabs…” button at the bottom of the dialog box that appears. This will bring up a new dialog box. 
	 
	  
	Figure
	Figure

	Figure
	Clear any tab stops that have already been entered by clicking the “Clear All” button. At the top of the dialog box, enter a new tab stop position of 6”. Since your left and right margins must be set at 1.25”, a 6” tab stop will ensure that your tab will align on the right margin.  
	 
	Under “Alignment,” select “Right,” and under “Leader,” select the second option (a line of dots). Next, make sure you click “Set” before clicking “OK.”  
	 
	 
	Figure

	 
	Now, when you insert a tab at that position in your document, it will automatically align on the right margin and include a leader from the location you enter the tab. You may also format multiple tabs using this interface; to do so, simply type another length in the “Tab stop position” field. For instance, if you wanted the first tab on a line to be .5” and the second to be 6”, you would first type “.5” in the field, then click “Set,” then type “6” and click “Set” again. Don’t forget to adjust the “Alignme
	 
	 
	Creating a Hanging Indent 
	 
	For entries longer than one line in your table of contents, list of tables, and list of figures, you will need to use a hanging indent. Because you must set up your tabs to use as leaders (lines of dots), you will not be able to use the “tab” button to create this indent. However, you can use the hanging indent option in MS Word to achieve this effect.  
	 
	First, write all entries for your table of contents (or list of tables, list of figures, etc.). Create the leaders for each entry and insert the page numbers.  
	 
	When you add these entries, go ahead and split the text for entries longer than one line. This will ensure there is blank space above the page number, keeping your table of contents (or list of tables, list of figures, etc.) easier to read.  
	 
	  
	 
	Figure

	 
	Then, you will highlight the content you want to indent. Then, right-click the content to bring up the “Paragraph” menu. 
	 
	  
	Figure
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	Figure
	  
	Then, in the indentation section, you will select “Hanging” under special. In the box labeled “by:”, you will enter “0.5”. Likewise, you will enter “0.5” in the “Left” box. This will ensure your hanging indent is 0.5 inches. Then, click “Ok” to finalize the process.  
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	After taking these steps, your table of contents should be formatted properly.  
	 
	 
	Figure

	 
	Remember that these steps apply to all entries that are longer than one line in the table of contents, list of tables, and list of figures.   
	Embedding Fonts 
	 
	ProQuest/UMI requires that all fonts be embedded in your document before you upload it to their site. Embedding fonts ensures that the content of your document will be viewable on all computers. To embed fonts in MS Word 2010, first click the “File” tab in the top left of the window, then click “Options.” In the new dialog box that appears, click “Save” on the left side. At the bottom of the window, make sure there is a check in the box beside “Embed fonts in the file,” and that there is not a check in the 
	 
	 
	Assembling Your PDF 
	 
	The final document that you submit must be in a single PDF file, but there are several ways you could create that file. The first is to create a single MS Word file, ensure that all formatting requirements have been met, and then convert that file to PDF. You may either convert the MS Word file to PDF yourself prior to submission, or you may use the conversion tool on the ProQuest/UMI site to convert your MS Word file to PDF. 
	 
	However, if you are having trouble with the formatting features of MS Word, it is also possible to create multiple files (one for the title page, one for the table of contents, one for the main body, etc.), convert each one to PDF, then combine them all into a single PDF using Acrobat Pro or some other PDF editing software. If you decide to use this method, you may want to use the individual templates for each section (such as title page, abstract, table of contents, etc.) provided by the Graduate School. K
	 
	 
	ADDITIONAL RESOURCES 
	ADDITIONAL RESOURCES 
	Figure

	Graduate School Website 
	The Graduate School’s website has two pages with detailed information about thesis and dissertation requirements, deadlines, processes, workshops, and even an copy of this guide.  
	 
	 has general information about ETDs, including a link to ProQuest’s ETD site.  
	Thesis & Dissertation

	 
	 has more specific information, including templates and samples, all of which you can download.  
	Formatting Your Thesis or Dissertation

	 
	 
	Electronic Thesis and Dissertation Workshops 
	Each semester, the Graduate School hosts several formatting workshops, both in-person and virtually. You can read about these workshops and register for them by visiting the , the Graduate School’s  page, or the  for the university.  
	Graduate School Calendar
	Thesis & Dissertation
	Opportunities Board

	 
	These workshops provide information on thesis and dissertation formatting, the format check and submission processes, and useful tips for navigating your ETD account.  
	 
	 
	LaTeX Files 
	Often, students in the STEM fields choose the LaTeX format because it can accommodate large equations while still maintaining the Graduate School’s formatting requirements. You can access these files on the . This page also has instructions and external links to LaTeX distribution options.  
	Graduate School’s website

	 
	 
	Scholar Commons 
	Scholar Commons is the university’s own repository, and it is run by the UofSC library system. Your ETD will be stored in this database, which you can locate through Thomas Cooper Library’s database website: .  
	https://scholarcommons.sc.edu/

	 
	 
	ProQuest’s ETD Administrator Help 
	If you need help with anything specifically related to ProQuest, such as ordering a hard copy or fixing a technical issue with your ETD account, you can contact them directly through .  
	this link

	 
	 
	Order Hard Copy from the Russell House 
	You can order a hard copy through ProQuest when you create your ETD account. Another option for ordering hard copies of your ETD is to use the Russell House’s print shop. You can read about their printing options at .  
	this link






